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1 INTRODUCTION 

FactoryWidgets conveniently reside on your desktop and deliver easy-to-read, Wonderware Historian- and OPC-

based, live data indicators, such as production rates, energy usage, goal attainment, yield, safety, and asset 

utilization— to name just a few. 

 Suitable for desktop, laptop or shop floor message displays 

 Do not need a Web browser to open 

 Centrally-managed licensing 

 Affordable pricing 

Set up is simple. There is no complicated software to install on the client PC. FactoryWidgets leverage your 

investments in your manufacturing hardware and software. The WidgetServer component (included) is 

lightweight, installs in minutes, and connects to your Wonderware Historian and OPC data sources. 

FactoryWidgets are secure and read-only. Because the FactoryWidgets update on an interval specified by the 

user, they do not burden your network.  

 Connect to Wonderware Historian and OPC data sources locally and throughout your enterprise 

 Configure units of measure and title on each Factory Widget to match your business terminology 

 Set colors on each Factory Widget to suit your needs 

 Link FactoryWidgets to any content that is delivered to your Web browser, such as reports, dashboards, 

and HMI screens, to drill down to detail behind the data 
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2 SYSTEM REQUIREMENTS 

To install and run FactoryWidgets, your system must meet the following requirements. 

2.1 WidgetServer Requirements 

 .NET Framework 3.5 SP1 

 Access to Wonderware Historian (InSQL 9.0 or higher) and/or OPC DA servers 

 Operating systems: 

o Windows Server 2003, Windows Server 2008, Windows Server 2008 r2 or higher 

o Windows XP Pro SP3, Windows Vista Business, Windows Vista Enterprise, Windows Vista 

Ultimate, Windows 7 Professional, Windows 7 Ultimate*  

 30 MB disk space to install and store configuration files 

 50 MB free memory not in use by operating system or other applications 

 

* If you run the WidgetServer on a desktop class operating system, the operating system may limit the number of 

concurrent network connections to the WidgetServer to 10, which may limit the number of FactoryWidgets connected to 

the WidgetServer at one time to 10. Run the WidgetServer on a supported server class operating system to avoid these 

operating system-imposed limitations. 

 

2.2 Client (Desktop) Requirements 

 Operating System: Windows Server 2008*, Windows Server 2008 r2*, Windows 7, Windows Vista, 

Windows XP (Service Pack 3)* 

 Browser: Internet Explorer 7 or higher (installed) 

 10 MB free disk space 

 64 MB free memory not in use by operating system or other applications    

* The Windows Gadget Gallery and the Windows sidebar are not native to the Server 2008, Server 2008 r2 or XP operating 

systems. In order to install the sidebar and extract the FactoryWidgets to a computer running Windows Server 2008, 

Windows Server 2008 r2 or Windows XP, you must follow a few extra steps. See section 4.1 for information and steps.  
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3 WIDGETSERVER 

The WidgetServer is a service that runs on a computer, connects to the Wonderware Historian or OPC data 

source, and serves the live data to the FactoryWidgets.  The WidgetServer also manages the persistence (type, 

quantity used, user, etc.) of FactoryWidget instances and implements the FactoryWidget licensing.  

Figure 1: WidgetServer serves live data to FactoryWidgets on desktops 

 

→ Note:  This document assumes Historian or OPC data sources are already 

installed and configured on your system. Configuring an OPC server is 

outside the scope of this document, however, this Software Toolbox link 

provides resources and recommendations for DCOM, OPCEnum and 

OPCServer settings: 

http://www.softwaretoolbox.com/dcom 

  

http://www.softwaretoolbox.com/dcom
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3.1 Installing the WidgetServer 

An installation wizard walks you through the steps to install the WidgetServer. If this is the first time you have 

installed the WidgetServer, proceed now to section 3.1.1, Installing a New WidgetServer, on the next page. 

If you have previously installed an earlier version of the WidgetServer, you may need to uninstall the previous 

version before installing the new version. Check the table below to determine if you need to uninstall the 

previous version. 

Do you need to uninstall the previous WidgetServer before installing the new version? 
What is your current 

WidgetServer version 

number?  

What version are you 

upgrading to? 

Do you need to uninstall the previous 

WidgetServer version before installing the 

new version? 

3.1.0.* 3.1.1.* No. Proceed to section 3.1.1, Installing a 

New WidgetServer. 

3.1.1.* 3.1.1.* Yes. Proceed to section 3.1.2, Upgrading 

WidgetServer from a Previous Version, 

before installing the new version. 

3.1.1.* 3.1.2.* No. Proceed to section 3.1.1, Installing a 

New WidgetServer. 

3.1* 3.2* No. Proceed to section 3.1.1, Installing a 

New WidgetServer. 

3.2.1* 3.2.2* No. Proceed to section 3.1.1, Installing a 

New WidgetServer. 

3.2.2* 3.2.3* No. Proceed to section 3.1.1, Installing a 

New WidgetServer. 

3.2.3* 3.2.6* No. Proceed to section 3.1.1, Installing a 

New WidgetServer. 

 

If you need to uninstall the previous version, but try to install a new version without uninstalling, you will see an 

error message similar to one of the following. 
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Figure 2: Windows Installer alerts 

   

If you see this message, click OK and then proceed to section 3.1.2 to uninstall the previous version first 

before upgrading to the new version. 

 

 

3.1.1 Installing a New WidgetServer 

1. If you downloaded the installation file, double-click the setup file, FactoryWidgets.msi (Windows 

Installer Package file), to install the WidgetServer. If you received FactoryWidgets on a CD, the CD will 

play automatically when inserted into your CD drive. (If it does not, click setup.exe from the root 

directory of the CD.) 

The installation program starts and the Welcome window appears. 

Figure 3: FactoryWidgets WidgetServer Setup Welcome 

 

2. Click Next. The end-user license agreement appears. 
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Figure 4: End-User License Agreement 

 

3. Review the agreement (you can click Print to print it out), then check to accept the terms of the license 

agreement, and click Next. The Custom Setup window appears. 

Figure 5: Custom Setup 

   

4. Click the plus sign ( ) to expand the FactoryWidgets WidgetServer icon to see the components you are 

installing.  

 To install the components somewhere other than the default location listed, click Browse to select a 

different location, and then click Next.  

 Otherwise, just click Next to accept the default location and to continue. 
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Figure 6: Ready to install 

 

5. When you are ready to install, click Install. Installation may take a few minutes.   

Figure 7: Firewall exception 

 

6. Select the appropriate firewall option: 

 Default Port (TCP port 4700) – Use this type of firewall rule to allow a connection based on the 

default TCP port for the FactoryWidgets WidgetServer. If you later change the port number on 

which the WidgetServer listens, you will need to manually adjust your Windows firewall exceptions. 

 Do not add Windows Firewall exception – Use this selection if you do not want to create a 

Windows Firewall exception at this time. Unless you are not running Windows Firewall, you will 

have to manually configure an exception in order for FactoryWidgets to connect to the 
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WidgetServer. The WidgetServer uses TCP port 4700 by default and you may change the port in the 

WidgetServer Configurator (which may be launched at the end of this install process). 

After you have made your selection, click Next to complete the installation.  

Figure 8: Finish the installation 

 

7. Click Finish. 

Continue to the next section to register your FactoryWidgets, and then configure your FactoryWidgets. 

3.1.2 Upgrading WidgetServer from a Previous Version 

If you have previously installed an earlier version of the WidgetServer, and you have determined that you must 

uninstall the previous version before installing the new version (using the table on page 4), use these steps. 

Windows Server 2008 users: 

1. Go to the start menu, click Settings, click Control Panel, and then click Programs and Functions. 

2. Select FactoryWidgets WidgetServer in the list of programs, and then click Uninstall. 

Windows Server 2003 users: 

1. Go to the start menu, click Control Panel, and click Add or Remove Programs. 

2. Select FactoryWidgets WidgetServer from the list of programs, and then click Remove. 

After removing the previous version, return to section 3.1.1 to follow those steps to install the new version. 

  



www.factorywidgets.com Administrator’s Guide 

FactoryWidgets
TM

  Page | 9 

3.2 Registering your FactoryWidgets (Licensing) 

If you purchased the FactoryWidgets in a download, you will receive an email with a serial number that you will 
need to “unlock” your FactoryWidgets in order to register and use them. If you received your FactoryWidgets on 
a CD, the serial number is displayed on the front of the CD case, as well as being delivered by email (provided 
you supplied a valid email address when ordering).  
 
Registering your FactoryWidgets is a quick, two-step process: 
Step one: Enter your serial number 
Step two: Unlock and register FactoryWidgets  
 

Step one: Enter your serial number 

1. Open the License Manager by doing one of the following: 

 

 Open the WidgetServer Configurator, go to the Help menu, and select License Manager. 

OR 

 Go to your start menu, click Programs (Windows XP, Windows Server 2003 and 2008) or All 

Programs (Windows Vista, Windows 7), click FactoryWidgets, and then click License Manager. 

 

→ Note:  If you are opening License Manager from the start menu on a 

computer running Windows Vista, Windows 7, or Windows Server 

2008, and User Account Control (UAC) is enabled, right-click License 

Manager from the start menu > Programs > FactoryWidgets menu, and 

then select Run as Administrator. 

 

2. Select WidgetServer from the License drop-down menu.  Your computer ID number will appear in the 

Computer ID field. 

 

3. Enter your serial number (provided in the download email) in the Serial Number field. Once the serial 

number is accepted, the other information boxes will clear for entry. 

 

4. Enter your information in the personal information fields. 
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Figure 9: License Manager 

 

Step two: Unlock and register FactoryWidgets 

1. Go to the Unlock and Register menu in the License Manager to unlock and register your 

FactoryWidgets. You can unlock and register FactoryWidgets automatically if you have internet access, 

or you can unlock and register manually from the Unlock and Register menu if you do not have internet 

access.  

 

2. For computers connected to the Internet, select Automatically via Internet. If you get a “success” 

message, you are now registered and can continue to the next section to configure your WidgetServer. 

If your registration did not go through successfully, or if your computer is not connected to the Internet, 

do the following: 

a. Copy down your Computer ID and your Serial number as shown in the License Manager screen. 

b. Go to a computer this is connected to the Internet and go to (FactoryWidgets do not need to be 

installed on this computer): http://registration.softwaretoolbox.com  

c. Click Register Now, then select FactoryWidgets from the list of products, and then complete the 

registration form for FactoryWidgets. When you submit the form, your unlock code will display on-

screen. 

d. Record the code and return to the computer where you have the WidgetServer installed.  

e. Open License Manager again, if it is not still open, go to the Unlock and Register menu, and select 

Manually. 

http://registration.softwaretoolbox.com/
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f. Enter the code you just received online in the Unlock Code field. Make sure there are no extra 

spaces after the number in the field, and then click Register. You are now registered.   

→ Note:  If you still are unable to unlock and register your FactoryWidgets, click 

Help in the License Manager to contact support, or email 

support@softwaretoolbox.com.  

Figure 10: Contact support 

 

→ Note: For additional information about the license agreement, see the entire 

agreement in Appendix A of this document. It is also available online: 

  License Agreement:  http://www.factorywidgets.com/eula 

 

  

mailto:support@softwaretoolbox.com
http://www.factorywidgets.com/eula
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3.3 Configuring the WidgetServer 

After you have installed and registered the WidgetServer, configure your WidgetServer to serve data to the 

FactoryWidgets, to test your data sources, and to administer your FactoryWidgets to your users per your 

licensing arrangement.  

 Open the WidgetServer, if it is not already open:  go to your Start menu, click Program or All Programs, click 

FactoryWidgets, and then click WidgetServer Configurator.  The WidgetServer will open, showing the Data 

Sources tab, and the WidgetServer icon will display in your system tray ( ). 

Figure 11: WidgetServer Configurator 

 

The Data Sources tab displays upon first opening the WidgetServer Configurator. This tab displays all currently 

configured data sources: data source name, server name, server type and server status. The radio button is 

selected in the Default field of one of the rows; this indicates that the data source listed in this row is currently 

the default data source. You cannot edit the data in this tab, but you can sort the entries in each of the columns 

by clicking the column header.  

If this is the first time you have installed the WidgetServer and you have not yet configured a data source, this 

tab will be empty. 

You can modify the information that displays in this tab data source information in the Historian and OPC tabs, 

which are discussed later in this section. 

→ Note:  When the WidgetServer Configurator opens, the status bar across the bottom of the window 

shows the service status, the license capacity, and the WidgetServer version.  

Figure 12: Status bar 
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3.3.1 WidgetServer Configurator Menu Options 

The WidgetServer Configurator has six menus. Review these items below to understand the menu structure and 

which tasks you can accomplish from these menus.  

File menu 

From the File menu, you can click Exit to exit and close the WidgetServer Configurator. 

Edit menu 

From the Edit menu, you can select Options to open the Options tab, where you can distribute the 

FactoryWidget licenses to users, and you can designate a server port, if necessary. 

View menu 

The View menu leads to several tabs where you will probably spend the majority of your time.  

Figure 13: View > Data Sources menu 

 
 

 Select Data Sources to open the Historian or OPC tabs, where you can configure and manage your Historian-

based or OPC-based data sources.  

 Depending up on the mode you elect to use to distribute your FactoryWidget licenses to users, you can click 

Active Users or User Licenses (or both) to open those respective tabs to distribute FactoryWidgets to users.  

 Finally, click Widget Settings to open the Widget Settings tab, where you can manage FactoryWidget 

configurations. 

Service menu 

You can manually stop, start or restart service.  
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Figure 14: WidgetServer Configurator's Service menu 

 

Refresh  

Click Refresh to update to see the most recently saved configurations in the Widget Settings tab (View menu). 

Figure 15: WidgetServer Configurator's Refresh button 

 

Help menu 

There are several options available from the Help menu. 

Figure 16: WidgetServer Configurator's Help menu 

 

 Click Help File to access a PDF of this document, the FactoryWidgetsTM Administrator’s Guide. 

 Click Buy More Widgets to purchase additional FactoryWidgets from the FactoryWidgetsTM Web site. 

 Click License Manager to register and activate your FactoryWidget licenses. 

 Click About to see your WidgetServer version number. 

 Click Check for Updates to see if there is an update to your current version of the WidgetServer. 

  

http://www.factorywidgets.com/
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3.3.2 Managing, Adding, and Deleting Historian-based Data Sources 

FactoryWidgets communicate with Historian and OPC data sources. Each type of data source has its own tab 

under Data Sources in the View menu. Manage, add and delete Historian-based data sources in the Historian 

tab. You may also test tag names for use with your Historian-based data source(s), and associate friendly names 

to your valid tag names for use with the FactoryWidgets. 

 

 Click the View menu, select Data Sources, and then click Historian.   

Figure 17: Historian tab 

 

Field Description 

Data Source Enter the name of your choice for the Wonderware Historian data source. The 
WidgetServer can access multiple Wonderware Historians, so if you have multiple data 
sources, you can enter “friendly” data source names that provide more context for you and 
your business.  

Server Enter or browse for the name of the server PC on which the Historian data source resides.  
 
If the WidgetServer is not installed on the same domain as the data source, you can enter 
the IP address of the server PC hosting the data source. 

Username & Password Enter the username and password. This is a SQL server login, not your Windows 

authentication login. 

→ Note:  The suggested username/password are wwUser/wwUser. This is a 

profile that is installed with InSQL that has read-only rights. 

 

3.3.2.1 Testing a Data Source 

One you have entered a row in the Historian tab that defines your data source, test the data source you have entered 

to verify that it is valid. If the data source makes a successful connection, a green “success” message appears, 

indicating the data source to which you connected is valid. If a red “failure” message displays, the data source is 

invalid. Check your data source and your spelling and try again. 

 One you have entered a row in the Historian tab that defines your data source, server, and username and 

password, click Test Data Source in that same row to test the data source to verify that it is valid. 
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Figure 18: Test Data Source (successful test) 

 

3.3.2.2 Making a Default Data Source 

You must select one of your data sources to be your default. When you configure your FactoryWidgets, this data 

source is the automatic default in your FactoryWidgets (which means you do not have to re-enter the data source 

information in the FactoryWidgets), unless you indicate a different data source in the FactoryWidget itself. 

To indicate a default data source, go to the Data Sources tab (the tab that always displays first when you open the 

WidgetServer Configurator), and click to select the radio button in the Default field, directly to the left of the data 

source, to set the data source in that row as the default data source. 

→Note: You can only have one default data source. 

3.3.2.3 Testing a Tag 

After you have verified your data source and have made a successful connection, test the tags that you want to 

use with that data source.  

1. In the same row in the Historian tab where you tested the data source, now click Test Tag to make sure the 

tags you want to use with this data source are valid.  

2. In the Test Tag tab, enter either the Alias name or the Historian tag name and click Test.  

If the tag name is valid, the parameters associated with that tag will display. If the tag name is not valid, a “Tag Not 

Found” message displays. An invalid tag name is either not in use with the data source with which you are testing the 

tag, or the tag name contains a typo. Double-check the spelling of the tag name and try again.  NOTE: All tag names 

are case sensitive. 
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Figure 19: Test Tag (successful test) 

 

3.3.2.4 Editing a Tag 

After you have verified a valid tag name for use with the data source, you can assign a friendly name or “Alias” to that 

tag.  

1. In the same row in the Historian tab where you have tested your data source and tested your tags, click Edit 

Tags. 

2. Enter a friendly name in the Alias field and enter the existing tag name in the Tag Name field. Then, press 

Enter.  

Figure 20: Edit Tags tab 

 

Now, you can use the Alias name in the FactoryWidgets. To double-check that the Alias name is correctly associated 

with a tag, test the Alias name with Test Tag. 
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3.3.2.5 Importing and Exporting Tags 

Because many systems have hundreds, or even thousands, of tags, entering them into Historian data sources 

can be cumbersome and time-consuming. Many systems engineers use tools such as Excel or other text editors 

to create lists of tags, in comma-separated-variable (*.csv) format, for use in their HMI or PLC programs. The 

same technique can be used with FactoryWidgets. Once you have created the .csv file, you can import that file 

into the WidgetServer Configurator so that you do not have to manually enter each tag. 

Figure 21: Import and Export buttons on the Edit Tags tab 

 

To import tag names to the WidgetServer Configurator: 

1. Create the .csv file. 
 

Figure 22: Example Excel file of tag names to be imported 

 

→Note: The example shows Excel as the text editor, with spreadsheets saved in *.csv 

format. If using Excel, Alias Names must be in Column A and Tag Names in 

Column B. Spreadsheet columns must not have headers.  

 
2. Click Import Tags in the Edit Tags tab and browse to locate the .csv file. Once located, click Open. 
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Figure 23: Browse to locate .csv file to import 

 
 

3. A preview of what will be imported is presented to you asking you to Confirm or Cancel.  Click Confirm. 
 

Figure 24: Successfully imported tag names 
 

 
 

4. When the file has imported successfully the tags will be displayed in the Edit Tags tab. 
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Figure 25: Successfully imported tag names 

 
 

To export tag names from the WidgetServer Configurator: 

1. In the Edit Tags tab, click Export Tags to export your current tags for a selected data source. Browse to 
select the location where you want to save the .csv file and click Save. 

 
2. When the .csv files has successfully saved, a message displays, “Exported Tags Successfully.” Click OK. 
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3.3.3 Managing, Adding, and Deleting OPC-based Data Sources 

FactoryWidgets communicate with Historian and OPC data sources. Each type of data source has its own tab 

under Data Sources in the View menu. Manage, add and delete OPC-based data sources in the OPC tab. You 

may also test tag names for use with your OPC-based data source(s), and associate friendly names to your valid 

tag names for use with the FactoryWidgets. 

 

 Click the View menu, select Data Sources, and then click OPC.   

Figure 26: OPC tab 

 

Field Description 

Data Source Enter the name of your choice for the OPC data source. If you have multiple data sources, 
you can enter “friendly” data source names that provide more context for you and your 
business.  

Computer Name Enter or browse for the name of the computer on which the OPC server resides.  
 
If the WidgetServer is not installed on the same domain as the data source, enter the IP 
address of the server PC hosting the data source. 

OPC Server Select the OPC server from the drop-down list. 

 
Figure 27: Select an OPC server 
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Field Description 

Group Name The group name increments chronologically. You can modify the group names to your 

needs if you use groups. 

Scan Rate The scan rate defaults to 1000 milliseconds. You can modify this rate at which the OPC 

server checks for new data.  

3.3.3.1 Testing a Data Source 

One you have entered a row in the OPC tab that defines your data source, you can test the data source you have 

entered to verify that it is valid. If the data source makes a successful connection, a green “success” message appears, 

indicating the data source to which you connected is valid. If a red “failure” message displays, the data source is 

invalid. Check your data source and your spelling and try again. 

 One you have entered a row in the Historian tab that defines your data source, computer name, OPC server, and 

optionally, a group name and scan rate, click Test Data Source in that same row to verify that it is valid. 

Figure 28: Test Data Source (successful test) 

 

3.3.3.2 Making a Default Data Source 

You must select one of your data sources to be your default. When you configure your FactoryWidgets, this data 

source is the automatic default in your FactoryWidgets (which means you do not have to re-enter the data source 

information in the FactoryWidgets), unless you indicate a different data source in the FactoryWidget itself. 

To indicate a default data source, go to the Data Sources tab (the tab that always displays first when you open the 

WidgetServer Configurator), and click to select the radio button in the Default field, directly to the left of the data 

source, to set the data source in that row as the default data source. 

→Note: You can only have one default data source. 

3.3.3.3 Testing a Tag 

After you have verified your data source and have made a successful connection, test the tags that you want to 

use with that data source.  

1. In the same row in the OPC tab where you tested the data source, now click Test Tag to make sure the tags 

you want to use with this data source are valid.  

2. In the Test Tag tab, enter either the Alias of OPC tag name, and click Test. You can also use Lookup Tag to 

browse to the tag. 

If the tag name is valid, the parameters associated with that tag display or a message saying, “Valid Tag” displays. If 

the tag name is not valid, a “Tag Not Found” message displays. An invalid tag name is either not in use with the data 
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source, or the tag name contains a typo. Double-check the spelling of the tag name and try again.  NOTE: All tag 

names are case sensitive. 

Figure 29: Test Tag (successful test) 

 

3.3.3.4 Editing a Tag 

After you have verified a valid tag name for use with the data source, you can assign a friendly name or “Alias” to that 

tag.  

1. In the same row in the OPC tab where you have tested your data source and tested your tags, click Edit Tags. 

2. Enter a friendly name in the Alias field and enter the existing tag name in the Tag Name field. Then, press 

Enter.  

Figure 30: Edit Tags tab 

 

Now, you can use the Alias in the FactoryWidgets. To double-check that the Alias is correctly associated with a tag, 

test the Alias with Test Tag.  When doing so the full OPC Item name will populate in the Tag to Test textbox. 

3.3.3.5 Adding a Tag 

If there is tag that you want to use, but that is not currently associated with your data source, add the tag from 

the Edit Tag tab. 

1. To add a tag, click the Add Tags button in the Edit Tags tab and browse to locate the tag(s) to add. 
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Figure 31: Browse to locate tags to add 

 

2. Once located, click to select the tag in the right pane and then click OK at the bottom of the window. You can 

add tags individually or several at a time, using Ctrl+click or Shift+click. Once added, the selected tag(s) 

appear(s) in the Edit Tags window in the WidgetServer Configurator. 

Figure 32: Tags are now associated with data source in WidgetServer Configurator 

  

Once added, you can test the tags to ensure they work with your data source and you may associate an Alias 

with them. 
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3.3.3.6 Importing and Exporting Tags 

Because many systems have hundreds, or even thousands, of tags, entering them into OPC data sources can be 

cumbersome and time-consuming. Many systems engineers use tools such as Excel or other text editors to 

create lists of tags, in comma-separated-variable (*.csv) format, for use in their HMI or PLC programs. The same 

technique can be used with FactoryWidgets. Once you have created the .csv file, you can import that file into 

the WidgetServer Configurator so that you do not have to manually enter each tag. 

Figure 33: Import and Export buttons on the Edit Tags tab 

 

To import tag names to the WidgetServer Configurator: 

1. Create .csv file with tag names. 
 

Figure 34: Excel file of tag names to be imported 

 

→Note: The example shows Excel as the text editor, with spreadsheets saved in *.csv 

format. If using Excel, the Alias must be in Column A and Tag Names in Column 

B. Spreadsheet columns must not have headers. 

 

→Note: OPC Tag Names need to contain fully-qualified names as used in the specific 

OPC Server application. 
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2. Click Import Tags in the Edit Tags tab and browse to locate the .csv file. Once located, click Open. 

 
Figure 35: Browse to locate .csv file to import 

 
 

3. A preview of what will be imported is presented to you asking you to Confirm or Cancel.  Click Confirm. 
 

Figure 36: Successfully imported tag names 
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1. When the file has imported successfully the tags will be displayed in the Edit Tags tab. 

 
Figure 37: Successfully imported tag names 

 
To export tag names to the WidgetServer Configurator: 

1. Click Export Tags to export your current tags for a selected data source. Browse to select the location 
where you want to save the .csv file and click Save. 

 
2. When the .csv files has successfully saved, a message displays, “Exported Tags Successfully.” Click OK. 

  



www.factorywidgets.com Administrator’s Guide 

FactoryWidgets
TM

  Page | 28 

3.3.4 Distributing FactoryWidget Licenses to Users 

 Click the Edit menu to open the Options tab, where you can select the licensing mode to distribute your 

FactoryWidget licenses to users. 

 

→ Note:  The Search box at the top of the tab is simply to let you search for the licensing 

and service parameters. 

Figure 38: Licensing Options 

 

Field Description 

LicenseTimeout This is the default time for a license to expire after last active use. If a user closes a 
FactoryWidget on their desktop (is no longer actively using it), the FactoryWidget is 
“released” for use by another when the time entered in this field expires.  
 
Enter time in this format: hh:mm:ss. The default is 5 minutes. 

LicenseMode There are three licensing modes to choose from: 

 ConcurrentLicensing: Concurrent licensing allows any user to connect as many 

FactoryWidgets as they want, up to the licensing limit. 

 SeatLicensing: Seat licensing uses the configured user licenses to allocate licenses per 

user. 

 MixedConcurrentSeatLicensing: Mixed licensing allows for both licensing modes to be 

in use. For example: 

o If a user is assigned a certain number of widgets per seat licensing, but there 

are additional FactoryWidgets in the “pool” per the concurrent method, then 

the user may configure additional available FactoryWidgets from that pool; 

however, when that user’s PC is shut down, the FactoryWidgets obtained from 

the pool return to the pool.  

o If a user is not allocated any FactoryWidgets per seat licensing, that user may 

configure any available FactoryWidgets from the concurrent “pool.” 
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3.3.4.1 Using Concurrent Licensing Mode 

If you elect to use ConcurrentLicensing, the users can connect to as many FactoryWidgets as they want, up to 

the licensing limit.  

 Go to the Active Users tab in the View menu to see the tab automatically update to display active users 

and the FactoryWidgets they have installed and configured.  

Figure 39: Active User tab 

 

The list of active users is automatically updated at five second intervals. 

Field Description 

Computer Name Automatically updates when user installs and configures FactoryWidgets on computer. 

Username Automatically updates when user installs and configures FactoryWidgets on computer. 

Active Widgets Automatically updates when user actively uses FactoryWidgets on computer. When the 

user shuts down computer, the FactoryWidget is no longer considered active and it is 

returned to the pool for another user. 

Analog Orb 
Discrete Orb 
Goal 
KPI 
Readerboard 
Timer 

Automatically updates when user actively uses FactoryWidgets on computer. The number 

of each type of FactoryWidget in use displays here. 

  

Release All Widgets Click Release All Widgets to release all of a specific user’s FactoryWidgets back to the pool. 
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3.3.4.2 Using SeatLicensing Mode 

If you elect to use SeatLicensing, the users can connect to FactoryWidgets per the licenses allocated to them. 

 Go to the User Licenses tab in the View menu to enter the user information and the number of 

allocated FactoryWidgets.  

Figure 40: User Licenses tab 

 

→ Note:  The User Licenses tab is not accessible in ConcurrentLicensing mode. 

For each user, enter the following in the fields provided: 

Field Description 

Computer Name Enter the computer name. 

Username Enter the username. 

Allowed Widgets Enter the total number of FactoryWidgets the user is allowed. 
 
The default value is -1. It simply means that no specific number of widgets have been 
allocated to the user. 
 
If you change the number of FactoryWidgets allocated to a user or users, you must restart 

the WidgetServer service. After changing the allocation, and upon pressing Enter or clicking 

in a different row, a warning message appears as a reminder: “WARNING: Allowed widgets 

per user will not be applied until WidgetServer is restarted.”  
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Field Description 

 

It is recommended that you make all allocation changes and then restart the WidgetServer 

in order to avoid interrupting existing users multiple times. (See section 3.3.7 for restarting 

service.) 

 

3.3.4.3 Using Mixed Licensing Mode 

If you elect to use the MixedConcurrentSeatLicensing option, this means you can use a combination of the two 
licensing modes.  
 

First, remember, the status bar at the bottom of the WidgetServer Configurator shows the number of licenses 

the WidgetServer is licensed for and how many of those licenses your users are currently using.   

Figure 41: Number of licenses in status bar 

 

Now, consider the following scenario as a means of explanation for using both (mixed) licensing modes. 

 The WidgetServer in the image above is licensed for 10 FactoryWidgets. 

 Employee A is allowed five FactoryWidgets per SeatLicensing mode.  

Figure 42: Number of licenses in status bar 
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 Since Employee A has five, there are five FactoryWidgets still available. These can either be assigned to 

additional user(s) per seat licensing mode, or they can be made available to additional user(s) per 

concurrent licensing mode.   

When using the mixed licensing mode, users can take advantage of both kinds of licensing modes to use more 

FactoryWidgets. This means that if no other users are using FactoryWidgets, Employee A is free to use any or all 

of the remaining five licenses available per the concurrent mode, over and above the five he is already allowed 

per seat licensing mode.  

In this scenario, Employee A is now using all current licenses. This means that no other users can use 

FactoryWidgets until Employee A closes his “concurrent” widgets or shuts down his PC.  

If Employee B had been using a license yesterday in concurrent mode, but powered down her computer at the 

end of the day, then her widget license returned to the “pool.” When she logs in today, while Employee A has all 

10 licenses, the FactoryWidget on her desktop will display, “No Licenses Available,” and she will not be able to 

use it. 

When Employee A does shut down his PC, the five licenses granted to him per seat licensing remain his, but the 

five he claimed through concurrent licensing will return to the “pool” for other users. 

→ Note: When using MixedConcurrentSeatLicensing mode, if you change the number of 

FactoryWidgets allocated to a user or users in the User Licenses tab, you must 

restart the WidgetServer service. After changing the allocation, and upon 

pressing Enter or clicking in a different row, a warning message appears as a 

reminder: “WARNING: Allowed widgets per user will not be applied until 

WidgetServer is restarted.” 
 

 
 

                 It is recommended that you make all allocations changes and then restart the 

WidgetServer in order to avoid interrupting existing users multiple times. (See 

section 3.3.7 for restarting service.) 
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3.3.5 Designating a Server Port (if necessary) 

 Click the Edit menu to open the Options tab, where you can designate a server port, if necessary. 

 

→ Note:  The Search box at the top of the tab is simply to let you search for the licensing 

and service parameters. 

Figure 43: Port Designation 

 

Field Description 

Port Designate a WidgetServer TCP port number. This should be a value greater than 1024 and 

less than 65535, and it should not be in use by any program or service.  

The default is 4700. You can click the arrows in the right side of the Port field to increment 

or decrement the port number.  

→ Note:   If you change the port, the WidgetServer will prompt you to 

restart service. 

 

3.3.6 Managing FactoryWidget Configurations 

 To manage FactoryWidget configurations, go to the View menu and click Widget Settings to open the 

Widget Settings tab. 

This tab contains a list of global configurations and user-created widget configurations for each FactoryWidget 

connected to that server. The configuration data is entered and saved in the FactoryWidget itself, and then it is 

reflected here. Once in the Widget Settings tab, you can edit the configuration name and description. You can 

also designate a configuration as “global,” meaning all users have access to the configuration. Other users can 

load a global configuration, but they cannot overwrite it. See section 4.3.2 for additional information on saving 

and loading configurations. 

Among other uses, a global configuration is helpful to use as a baseline FactoryWidget configuration. When 

users add new widgets to their desktops, they can quickly load some basic settings by loading a global 

configuration, and then add to their configurations from there. This saves time over manually adding all 
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configuration data by hand each time they add a new FactoryWidget or upgrade their FactoryWidgets from one 

version to the next.     

Figure 44: Widget Settings tab 

 

Field Description 

Name The name given to the configuration when saved in the widget itself. 

Description A description given to the configuration when saved in the widget. This is optional. 

Global Check this box if the configuration is to be a global configuration, available to all users. 
Users cannot overwrite global configurations. 

Widget Type The widget type displays (Analog Orb, Discrete Orb, Goal, KPI, or Timer). 

Username The name of the computer and the name of the user using the configuration display here. 

Refresh While in the Widget Settings tab, click the Refresh tab in the WidgetServer Configurator’s 

top level menu in order to refresh the data to see the most recent saved configurations. 
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3.3.7 Stopping and Starting Service 

Generally, the WidgetServer will prompt you any time you need to stop, start, or restart service. For example, if 

you have made a change to your configuration, like changing the port number, you will be prompted to restart 

service and the WidgetServer will do it for you when you acknowledge the message.  

You can also manually stop, start and restart service by selecting the appropriate action from the Service menu. 

Figure 45: WidgetServer Configurator's Service menu 

 

One instance where you might want to manually stop and start the service is when upgrading the WidgetServer. 

You can avoid having to reboot your system if you stop service, install the upgrade, and then restart. 
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3.4 Checking for Updates 

When an update is available, you will receive an email. Go to the WidgetServer Configurator’s Help Menu and 

select the option to Check for Updates.  

Figure 46: WidgetServer Configurator's Help menu 

 

→ Note:   If you have opted out of receiving global emails from Software Toolbox, you 

may not receive notice of these updates. 

The most current version of FactoryWidgets will always display on the FactoryWidgetsTM Web site. 

 

  

http://www.factorywidgets.com/
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4 FACTORYWIDGETS 

Now that the WidgetServer is installed to serve data to the FactoryWidgets, install the FactoryWidgets to your 

Windows Gadget Gallery (and desktop). The FactoryWidgets will conveniently reside on your desktop and 

deliver easy-to-read, live data indicators. 

If you are using Windows Server 2008 or 2008 r2 for the client installation, start with section 4.1.1. 

If you are using Windows XP for the client installation, start with section 4.1.2.  

If you are using any other supported operating system for the client installation, start with section 4.2. 

4.1 Installing FactoryWidgets on Operating Systems on which the 
Windows Sidebar is Not Native 

The Windows sidebar is not native to Windows Server 2008, Windows Server 2008 r2 or Windows XP. If you plan 

to use either of these as your client desktop, you must first install the Windows sidebar. Proceed to the 

appropriate of the following two sections to install the sidebar. 

4.1.1 Downloading and Installing Windows Sidebar (Windows Server 2008 or 2008 
r2 Client Desktop users ONLY) 

If you are using the Windows Server 2008 or 2008 r2 operating system for the client installation, you must follow 

these steps to install and run the Windows sidebar on your desktop.  

1. Go to www.factorywidgets.com/ossupport.asp for links to download the Windows sidebar installer. 

2. After downloading, unzip the file. 

3. Run the RUN_ME.bat file (batch script) to install the sidebar. 

After you have successfully installed the sidebar, you will be able to install the FactoryWidgets to the Windows 

Gadget Gallery on your Server 2008 or 2008 r2 computer, and have them display in your Windows sidebar and 

on your desktop.  Now, proceed to section 4.2. 

4.1.2 Downloading and Installing XP Utility (Windows XP SP3 Client Desktop users 
ONLY) 

If you are using the Windows XP operating system for the client installation, you must follow these steps to also 

install a utility to run the Windows sidebar on your desktop, and then download the sidebar. You must have the 

sidebar installed before you can run FactoryWidgets on your XP computer.  

→ Note: You must have Windows XP Service Pack 3 (SP3) installed. 
 

→ Note: Even if not using Windows Vista, you must be licensed owner of Vista. 

http://www.factorywidgets.com/ossupport.asp
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1. Go to www.factorywidgets.com/ossupport.asp for links to download Alky for Applications 1.1 for 

Windows XP.  

2. Download and install Alky for Applications 1.1 for Windows XP. 

→ Note: During installation, you may be prompted for a Vista key. You can click Next 

to ignore this or you can enter your Vista key if you have it. 

3. Restart your computer. You must restart, even if you are not prompted to do so. 

4. Go to www.factorywidgets.com/ossupport.asp for links to download the Windows sidebar installer (this 

download also includes some default Windows gadgets). 

5. After downloading, unzip the file for the Windows sidebar installer. 

6. Once unzipped, right-click the sidebar.inf file and select Install. 

7.  Restart your computer. You must restart, even if you are not prompted to do so. 

After you have successfully installed the utility and sidebar, you will be able to install the FactoryWidgets to the 

Windows Gadget Gallery on your XP computer, and have them display in your Windows sidebar and on your 

desktop.  Now proceed to section 4.2. 

4.2 Installing FactoryWidgets 

When you installed the WidgetServer, you also installed the “client installer.” The client installer is a separate 

installer designed to be run on the desktop computers where the FactoryWidgets will be used. The client 

installer puts the FactoryWidgets on your computer so that you can add them to the Windows Gadget Gallery 

and make them available to your desktop.   

If you are installing FactoryWidgets for the first time, follow the steps in sections 4.2.1 and 4.2.2.  

If you are upgrading your FactoryWidgets from a previous version, follow the steps in section 4.2.3. 

4.2.1 Running the Client Installer on the client computer where you want to use 
FactoryWidgets 

1. Either copy ClientInstaller to the client desktop computer where you want to install FactoryWidgets, or 

access it from that client computer over your network.    

→ Note: If you installed the WidgetServer in the default location, you will find the 
ClientInstaller by going to Program Files > FactoryWidgets > ClientInstaller 
on your C: drive (or the custom location where you selected to install the file 
during WidgetServer installation). Your network administrator can choose to 
share this folder on your network or copy ClientInstaller to another network 
share, or otherwise make it available for use on your desktop computer 
through a method of their choice.  

 

2. On the client desktop computer, from the location that you have access to the client installer, double-

click the setup file, FactoryWidgetsDesktopSetup.msi (Windows Installer Package file), to start the 

installation. The installation starts and Welcome window appears. 

http://www.factorywidgets.com/ossupport.asp
http://www.factorywidgets.com/ossupport.asp
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Figure 47: FactoryWidgets Setup Welcome 

 
 

3. Click Next. The end-user license agreement appears. 

Figure 48: End-User License Agreement 

 
 

4. Review the agreement (you can click Print to print it out), then check to accept the terms of the license 

agreement, and click Next. The Custom Setup window appears. 
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Figure 49: Custom Setup 

   
 

5. Click the plus sign ( ) to expand the FactoryWidgets icon to see the FactoryWidgets you are installing.  

 To install the widgets somewhere other than the default location listed in the window, click 

Browse to select a different location, and then click Next.  

 Otherwise, click Next to accept the default location and to continue. 

Figure 50: Ready to install 

 

6. When you are ready to install, click Install. Installation may take a few minutes.  
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Figure 51: Finish the installation 

 

7. Click Finish. 

4.2.2 Installing the FactoryWidgets in the Windows Gadget Gallery (and onto the 
desktop) 

1. Go to the location where the client installer installed the FactoryWidgets.  If you selected the default 

location, this is C: > Program Files > FactoryWidgets > Widgets (or the operating system drive, if not the 

C: drive).  

2. Double-click to open the Widgets folder, and you will see the individual FactoryWidget files (.gadget 

files). 

Figure 52: FactoryWidget files 

 
3. Double-click each individual FactoryWidget (.gadget file) to install it to the Windows Gadget Gallery. You 

will receive a confirmation message when each FactoryWidget has installed successfully. 

→ Note: If you are installing to Windows 7 and Windows Vista systems, you can check 
Install for All Users to install the FactoryWidget to multiple users at once. 
However, if you are installing to Windows XP systems, this may cause an 
error; install users individually. 
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 Windows 7 and Windows Vista users: 

Double-clicking each .gadget file also installs the FactoryWidgets to the Windows sidebar. If this 

is the first time you have installed FactoryWidgets, skip section 4.2.3 and go to section 4.3 now 

to configure your FactoryWidgets. 

 Windows XP users: 

Double-clicking each .gadget file only installs the FactoryWidget to the Windows Gadget Gallery.  

You still need to take one more step to install the FactoryWidgets to the Windows sidebar from 

the gallery. 

a. Open the Windows Gadget Gallery and locate the FactoryWidgets.  

b. Once you have located each FactoryWidget, you can do any of the following to install the 

FactoryWidgets to your desktop from the gallery: 

 Double-click the FactoryWidget to install it. 

 Right-click the FactoryWidget and select Install to install it. 

 Click and drag the FactoryWidget to the desktop to install it. 

Figure 53: FactoryWidgets installed in Windows Gadget Gallery 

 

→ Note:  FactoryWidgets (FW) are grouped together in the Windows Gadget Gallery.  
 

If this is the first time you have installed FactoryWidgets, skip section 4.2.3 and go to section 4.3 now to 

configure your FactoryWidgets.  
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4.2.3 Upgrading FactoryWidgets from a Previous Version 

To upgrade your FactoryWidgets from a previous version, complete the following five steps.  

→ Note: You must follow these steps due to current limitations in the Windows Gadget 
technology.  Future versions of FactoryWidgets may take steps to make this 
process easier.  

 

Step one: Record each of your FactoryWidgets’ current configuration settings  

1. Right-click each FactoryWidget and select Options to open the Options window for each. 

2. Record your current settings for each FactoryWidget, as you will need them later.    

→ Note: Beginning with FactoryWidgets v. 3.1.1.* you can save each of your 
configuration settings and will not have to manually record your 
configurations.  

 

Step two: Click the X to remove the FactoryWidgets from your desktop 

Step three: Make the Client Installer available to client computers 

1.  Copy the client installer (FactoryWidgetsDesktopSetup.msi) from your WidgetServer location to the 

client computer, network drive or shared folder on the WidgetServer. 

2. On the client desktop computer, from the location that you have access to the client installer, double-

click the setup file, FactoryWidgetsDesktopSetup.msi (Windows Installer Package file), to start the 

update.  

3. When the installation is complete, browse to C:\Program Files\FactoryWidgets\Widgets, if that folder 

does not open automatically. There are five .gadget files in the Widgets folder, one for each of the five 

FactoryWidgets.   

Step four: Install new version of FactoryWidgets 

1. Double-click each .gadget file to install it to the Windows Gadget Gallery.  

→ Note: Windows XP users will need to close and reopen the Windows Gadget Gallery 
to see the FactoryWidgets in the gallery. 

 

2. When prompted to uninstall the previous version, you can leave the previous version in the gadget 

gallery, however, it is recommended to uninstall all previous versions. 

 

 Windows Vista and Windows 7 users, the FactoryWidgets are now installed in your Widows sidebar.  

 Windows XP users, open the Windows Gadget Gallery, right-click each FactoryWidget, and select 

Install to add the FactoryWidget to your Windows sidebar. 
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→ Note: If you are not prompted to uninstall the previous version, you can manually 
uninstall the previous version of each FactoryWidget from the Windows 
Gadget Gallery by right-clicking the previous version of the FactoryWidget in 
the gallery and selecting Uninstall.   

 

 
 

 

Step five: Re-configure FactoryWidgets with the information recorded in Step one 

1. Right-click each FactoryWidget and select Options to open the Options window for each. 

2. Make sure the FactoryWidget version number (Options > About tab) matches the WidgetServer version 

number (WidgetServer Configurator > Help menu > About). 

3. Enter the configuration information you recorded earlier for each FactoryWidget. 

→ Note: Beginning with FactoryWidgets v. 3.1.1.* you can load previously saved 
configurations and do not have to manually add them back in.  

 

4.3 Configuring FactoryWidgets  

Each FactoryWidget installed on your desktop requires quick configuration to display the kind of data you want 

to see. During the configuration, there are also customizable features to enable each FactoryWidget to display 

the data in the way you want to see it – the way that makes the most sense to you and your business. 

 If this is the first time you have installed FactoryWidgets, proceed to section 4.3.1, Manually Configuring 

FactoryWidgets now. 

If you have installed FactoryWidgets before, the WidgetServer name from the most recent previously installed 

FactoryWidget will automatically default in the WidgetServer Name field of Data Source tab. If that most recent 

previously installed FactoryWidget also had the Data Source Name and WidgetServer Port fields defined (they 

were not using the default setting), then that information will also default into the Data Source name and Port 

number fields in your newly installed FactoryWidget. This information is editable and can be changed if you do 

not want the defaults. 

 To finish configuring, proceed to section 4.3.1 to manually enter the rest of the configuration 

information. If you want to load a previously saved configuration, go to section 4.3.2, Saving and 

Loading Settings. 
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4.3.1 Manually Configuring FactoryWidgets 

Configure each FactoryWidget in the Options window.   

1. Open the Options window by doing one of the following: 

 

 Right-click the FactoryWidget and then select Options from the pop-up menu  

OR 

 Roll your mouse over the FactoryWidget, and click the wrench icon ( ) that appears to the upper 

right of the FactoryWidget. 

2. Use the descriptions provided below to configure each of the FactoryWidgets. 
 

3. Remember to click OK to save your settings before exiting the Options window. 
 

The following sections review how to configure each FactoryWidget: 

 Analog Orb 

 Discrete Orb 

 Goal 

 KPI   

 Readerboard 

 Timer 

4.3.1.1 Analog Orb 

Use the following guidelines to configure the Data Source, Color, and FactoryWidgetTM tabs of the Analog Orb.  

 

 
The Analog Orb displays manufacturing and process data in real time. The 
FactoryWidget changes color according to configurable data threshold levels. 

Data Source tab 

 

WidgetServer Name  Enter your FactoryWidget server name. It must 
be an alphanumeric value. This is the Windows 
computer name of the machine hosting the 
WidgetServer. You may also enter the IP 
address of the server PC on which the 
WidgetServer is hosted. 
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Double-check for misspellings if you receive an 
“invalid” error upon entry. 

Advanced Data Source Settings  

 Click link to show hidden fields. 

 Fields are hidden because it is not always necessary to fill these 
in if the data source and port are defined in the WidgetServer. 

   Data Source Name If the data source you want to use for this 
FactoryWidget is the same data source that is 
selected as the default data source in the 
WidgetServer Configurator, then you do not 
need to enter it again.  
 
To connect to a data source other than the 
default, enter that data source name here, as 
it appears in the WidgetServer Configurator. 
Double-check for misspellings if you receive an 
“invalid” error upon entry. 

   WidgetServer Port This is the TCP/IP port number on which the 
WidgetServer is listening. The default is 4700. 
You should only change the port number here 
if you have changed the default on the 
WidgetServer. 
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 Tagname Enter your tagname. It must be an 
alphanumeric value. If you created an Alias for 
your tags in the WidgetServer Configurator, 
you can enter that here. Note that the Alias as 
entered in the WidgetServer Configurator is 
case-sensitive. 
 
Double-check for misspellings if you receive an 
“invalid” error upon entry. 

Unit of Measure Enter any unit of measure you require for the 
data you are tracking (EUs, units, %, etc.).  

Display Value Format From the drop-down menu, select the decimal 
format you want the FactoryWidget to 
recognize and use for your data values. The 
format you select displays under Preview. 

Refresh Rate From the drop-down menu, select the rate at 
which you want the data to the FactoryWidget 
to be refreshed from the data source. If you do 
not select a refresh rate, the rate defaults to 
five seconds. 

 

Color tab 

Use the color tab to set the value limits, and the text and body color of FactoryWidget when the value exceeds 

or drops below the specified limit. The display value format that you selected on the Data Source tab displays at 

the bottom of the Color tab as a reminder to enter your value limits in the decimal format you selected. You can 

enter positive and negative value limits. The highest value must be in the High High limit field, the next highest 

value must be in the High limit field, and so on, with the lowest value being in the Low Low limit field. 

 

High High 

   Text Click inside the text color box to display the 
color-picker. Select the color of text you would 
like to display on the FactoryWidget when it is 
at or above the “High High” level. Once you 
have selected a color, it displays in the text 
box. If you do not select a color, white 
defaults. 

   FactoryWidget
TM

 From the drop-down menu, select the color 
you would like the FactoryWidget to display 
when it is at or above the “High High” level. 

   Limit Enter a limit. When the data source value 
exceeds this threshold value, the 
FactoryWidget changes text and body color 
according to the settings you have indicated 
for this “High High” limit. 
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 High 

   Text Click inside the text color box to display the 
color-picker. Select the color of text you would 
like to display on the FactoryWidget when it is 
at or above the “High” level. Once you have 
selected a color, it displays in the text box. If 
you do not select a color, white defaults. 

   FactoryWidget
TM

 From the drop-down menu, select the color 
you would like the FactoryWidget to display 
when it is at or above the “High” level. 

   Limit Enter a limit. When the data source value 
exceeds this threshold value, the 
FactoryWidget changes text and body color 
according to the settings you have indicated 
for this “High” limit. 

Normal 

   Text Click inside the text color box to display the 
color-picker. Select the color of text you would 
like to display on the FactoryWidget when it is 
at or above the “Normal” level. Once you have 
selected a color, it displays in the text box. If 
you do not select a color, white defaults. 

   FactoryWidget
TM

 From the drop-down menu, select the color 
you would like the FactoryWidget to display 
when it is at the “Normal” level. 

 Low 

   Text Click inside the text color box to display the 
color-picker. Select the color of text you would 
like to display on the FactoryWidget when it is 
at or below the “Low” level. Once you have 
selected a color, it displays in the text box. If 
you do not select a color, white defaults. 

   FactoryWidget
TM

 From the drop-down menu, select the color 
you would like the FactoryWidget to display 
when it is at or below the “Low” level. 

   Limit Enter a limit. When the data source value 
drops below this threshold value, the 
FactoryWidget changes text and body color 
according to the settings you have indicated 
for this “Low” limit. 

Low Low 

   Text Click inside the text color box to display the 
color-picker. Select the color of text you would 
like to display on the FactoryWidget when it is 
at or below the “Low Low” level. Once you 
have selected a color, it displays in the text 
box. If you do not select a color, white 
defaults. 

   FactoryWidget
TM

 From the drop-down menu, select the color 
you would like the FactoryWidget to display 
when it is at or below the “Low Low” level. 
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   Limit Enter a limit. When the data source value 
drops below this threshold value, the 
FactoryWidget changes text and body color 
according to the settings you have indicated 
for this “Low Low” limit. 

 

FactoryWidgetTM tab  

Use the FactoryWidgetTM tab to give your widget a custom title and tooltip, and to link it to any Web site of your 

choice.  

 

Title Enter the title you have selected for this 
FactoryWidget. If you do not enter a title, 
“Analog Orb” defaults. 

Tooltip Enter the tooltip you would like the 
FactoryWidget to display when you single-click 
the widget on your desktop. If you do not 
enter a tooltip, “Analog Orb” defaults. 

User-defined Web Link Select the appropriate protocol from the drop-
down list, and then enter a Web link to which 
you would like to link to from this Analog Orb.  
 
Note that because you have selected the 
protocol in the drop-down, you do not have to 
enter that again as part of the Web address. 
 
When the FactoryWidget is running on your 
desktop, hover your mouse over the value on 
the FactoryWidget face. When the cursor turns 

into the pointing finger ( ), click to go to the 
link you defined. 

 Remember to click OK to save the configuration settings. 
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4.3.1.2 Discrete Orb 

Use the following guidelines to configure the Data Source, Color, and FactoryWidgetTM tabs of the Discrete Orb.  

  

 
The Discrete Orb displays the on/off state of a component or system in real 
time. The FactoryWidget changes color according to the state. 

Data Source tab 

 
 

 

WidgetServer Name Enter your FactoryWidget server name. It must 
be an alphanumeric value. This is the Windows 
computer name of the machine hosting the 
WidgetServer. You may also enter the IP 
address of the server PC on which the 
WidgetServer is hosted. 
 
Double-check for misspellings if you receive an 
“invalid” error upon entry. 

Advanced Data Source Settings  

 Click link to show hidden fields. 

 Fields are hidden because it is not always necessary to fill these 
in if the data source and port are defined in the WidgetServer. 

   Data Source Name If the data source you want to use for this 
FactoryWidget is the same data source that is 
selected as the default data source in the 
WidgetServer Configurator, then you do not 
need to enter it again.  
 
To connect to a data source other than the 
default, enter that data source name here, as 
it appears in the WidgetServer Configurator. 
Double-check for misspellings if you receive an 
“invalid” error upon entry. 

   WidgetServer Port This is the TCP/IP port number on which the 
WidgetServer is listening. The default is 4700. 
You should only change the port number here 
if you have changed the default on the 
WidgetServer. 
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 Tagname Enter your tagname. It must be an 
alphanumeric value. If you created an Alias for 
your tags in the WidgetServer Configurator, 
you can enter that here. Note that the Alias as 
entered in the WidgetServer Configurator is 
case-sensitive. 
 
Double-check for misspellings if you receive an 
“invalid” error upon entry. 

On State Enter any text you want to indicate the on 
state of the data being tracked. If you do not 
enter text to indicate the on state, "On" 
defaults. 

Off State Enter any text you want to indicate the off 
state of the data being tracked. If you do not 
enter text to indicate the off state, "Off" 
defaults.  

Refresh Rate From the drop-down menu, select the rate at 
which you want the data to the FactoryWidget 
to be refreshed from the data source. If you do 
not select a refresh rate, the rate defaults to 
five seconds. 

 

Color tab 

Use the color tab to set the color the text and Factory Widget should be when in the on and off states. 

 

On State 

   Text Click inside the text color box to display the 
color-picker. Select the color you would like 
the text to display on the FactoryWidget when 
it is reflecting the “on” state.  
 
Once you have selected a color, it displays in 
the text box. If you do not select a color, white 
defaults. 

   FactoryWidget
TM

 From the drop-down menu, select the color 
you would like the FactoryWidget to display 
when it is reflecting the “on” state. If you do 
not select a color, green defaults. 

 

  



www.factorywidgets.com Administrator’s Guide 

FactoryWidgets
TM

  Page | 52 

 Off State 

   Text Click inside the text color box to display the 
color-picker. Select the color you would like 
the text to display on the FactoryWidget when 
it is reflecting the “off” state  
 
Once you have selected a color, it displays in 
the text box. If you do not select a color, white 
defaults. 

   FactoryWidget
TM

 From the drop-down menu, select the color 
you would like the FactoryWidget to display 
when it is reflecting the “off” state. If you do 
not select a color, red defaults. 

 

FactoryWidgetTM tab  

Use the FactoryWidgetTM tab to give your widget a custom title and tooltip, and to link it to any Web site of your 

choice.  

 

Title Enter the title you have selected for this 
FactoryWidget.  
 
If you do not enter a title, “Discrete Orb” 
defaults. 

Tooltip Enter the tooltip you would like the 
FactoryWidget to display when you single-click 
the widget on your desktop.  
 
If you do not enter a tooltip, “Discrete Orb” 
defaults. 

User-defined Web Link Select the appropriate protocol from the drop-
down list, and then enter a Web link to which 
you would like to link to from this Discrete 
Orb.  
 
Note that because you have selected the 
protocol in the drop-down, you do not have to 
enter that again as part of the Web address. 
 
When the FactoryWidget is running on your 
desktop, hover your mouse over the state 
display (e.g., “running” or “stopped”) on the 
FactoryWidget face. When the cursor turns 

into the pointing finger ( ), click to go to the 
link you defined. 

 Remember to click OK to save the configuration settings. 
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4.3.1.3 Goal 

Use the following guidelines to configure the Data Source, Color, and FactoryWidgetTM tabs of the Goal.  

 

 
The Goal displays manufacturing and process data in real time. It shows 
performance versus a goal. The progress bar changes color according to 
configurable data threshold levels. 

 

Data Source tab 

 
 

 

WidgetServer Name  Enter your FactoryWidget server name. It must 
be an alphanumeric value. This is the Windows 
computer name of the machine hosting the 
WidgetServer. You may also enter the IP 
address of the server PC on which the 
WidgetServer is hosted. 
 
Double-check for misspellings if you receive an 
“invalid” error upon entry. 

Advanced Data Source Settings  

 Click link to show hidden fields. 

 Fields are hidden because it is not always necessary to fill these 
in if the data source and port are defined in the WidgetServer. 

   Data Source Name If the data source you want to use for this 
FactoryWidget is the same data source that is 
selected as the default data source in the 
WidgetServer Configurator, then you do not 
need to enter it again.  
 
To connect to a data source other than the 
default, enter that data source name here, as 
it appears in the WidgetServer Configurator. 
Double-check for misspellings if you receive an 
“invalid” error upon entry. 

   WidgetServer Port This is the TCP/IP port number on which the 
WidgetServer is listening. The default is 4700. 
You should only change the port number here 
if you have changed the default on the 
WidgetServer. 
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 Tagname Enter your tagname. It must be an 
alphanumeric value. If you created an Alias for 
your tags in the WidgetServer Configurator, 
you can enter that here. Note that the Alias as 
entered in the WidgetServer Configurator is 
case-sensitive. 
 
Double-check for misspellings if you receive an 
“invalid” error upon entry. 

Unit of Measure Enter any unit of measure you require for the 
data you are tracking (EUs, units, %, etc.). 

Refresh Rate From the drop-down menu, select the rate at 
which you want the data to the FactoryWidget 
to be refreshed from the data source.  
 
If you do not select a refresh rate, the rate 
defaults to five seconds. 

Display Value Format There is a separate Display Format for the 
Value and the Goal.  First click the ####### for 
the format you wish to change.  The Change 
Value Format dialog will appear. 
 
From the drop-down menu, select the decimal 
format you want the FactoryWidget to 
recognize and use for your data values. The 
format you select displays under Preview.  You 
can choose to enable or disable Trim Trailing 
Zeros.  Click OK to accept the settings. 
 
The Display Format on the Data Source tab 
should now show the new format setting. 

Goal Setpoint Indicate what kind of goal setpoint you are 
using by selecting Server Tag or Manual. 
 
Then enter the appropriate goal setpoint. If 
using a server tag, the setpoint will be a 
setpoint tagname. If using a manual goal 
setpoint, the value may be positive or 
negative. 

Display Goal This checkbox is checked by default. You can 
click to remove the check if you do not want to 
show the goal setpoint when the 
FactoryWidget is running.  
 
When you remove the check in this box, the 
unit of measure also does not display if it is 
not defined. 
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Color tab 
 
>  FactoryWidgetTM  
>  Progress Bar 
 

Use the color tab to set the body and text color of the FactoryWidget, as well as set the value limits, and the 

progress bar color when the value exceeds or drops below the specified values.  

 
 
 
 

FactoryWidget
TM

 Color 

FactoryWidget
TM

 Color From the drop-down menu, select the color 
you would like the FactoryWidget to display. 
This is a static color and will not change once 
selected. 
 
If you do not select a color, black defaults. 

Text Color Click inside the text color box to display the 
color-picker. Select the color you would like 
the text to display on the FactoryWidget. This 
is a static color and will not change once 
selected.  
 
Once you have selected a color, it displays in 
the text box. If you do not select a color, white 
defaults. 

 
The display value format that you selected on the Data Source tab displays at the bottom of the Color > 

Progress Bar tab as a reminder to enter your value limits in the decimal format you selected. You can enter 

positive and negative value limits. The highest value must be in the High High limit field, the next highest value 

must be in the High limit field, and so on, with the lowest value being in the Low Low limit field. 
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Progress Bar Color 

High High 

   Progress Bar From the drop-down menu, select the color 
you would like the progress bar to display 
when it is at or below the “High High” level. 

   Limit Enter a limit. When the data source value 
exceeds this threshold value, the progress bar 
changes color according to the settings you 
have indicated for this “High High” limit. 

High 

   Progress Bar From the drop-down menu, select the color 
you would like the progress bar to display 
when it is at or below the “High” level. 

   Limit Enter a limit. When the data source value 
exceeds this threshold value, the progress bar 
changes color according to the settings you 
have indicated for this “High” limit. 

 Normal 

   Progress Bar From the drop-down menu, select the color 
you would like the progress bar to display 
when it is at or below the “Normal” level. 

Low 

  Progress Bar From the drop-down menu, select the color 
you would like the progress bar to display 
when it is at or below the “Low” level. 

   Limit Enter a limit. When the data source value 
drops below this threshold value, the progress 
bar changes color according to the settings 
you have indicated for this “Low” limit. 

Low Low 

   Progress Bar From the drop-down menu, select the color 
you would like the progress bar to display 
when it is at or below the “Low Low” level. 

   Limit Enter a limit. When the data source value 
drops below this threshold value, the progress 
bar changes color according to the settings 
you have indicated for this “Low Low” limit. 

Background From the drop-down menu, select the color 
you would like to display as the background to 
the progress bar. 
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FactoryWidgetTM tab  

Use the FactoryWidget™ tab to give your widget a custom title and tooltip, and to link it to any Web site of your 

choice.  

 

Title Enter the title you have selected for this 
FactoryWidget.  
 
If you do not enter a title, “Goal” defaults. 

Tooltip Enter the tooltip you would like the 
FactoryWidget to display when you single-click 
the widget on your desktop.  
 
If you do not enter a tooltip, “Goal” defaults. 

User-defined Web Link Select the appropriate protocol from the drop-
down list, and then enter a Web link to which 
you would like to link to from this Goal.  
 
Note that because you have selected the 
protocol in the drop-down, you do not have to 
enter that again as part of the Web address. 
 
When the FactoryWidget is running on your 
desktop, hover your mouse over the value 
versus goal just below the title and above the 
progress bar on the FactoryWidget face. When 

the cursor turns into the pointing finger ( ), 
click to go to the link you defined. 

 Remember to click OK to save the configuration settings. 

4.3.1.4 KPI 

Use the following guidelines to configure the Data Source, Color, and FactoryWidgetTM tabs of the KPI.  

 

 
The KPI displays one master manufacturing metric, and up to three sub-
metrics, in real time. It shows performance versus goals. The progress bars 
change color according to configurable threshold levels. 
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Data Source tab 

>  Data Source 
>  Metric 1 (Master Metric)  
>  Metric 2 
>  Metric 3 
>  Metric 4 

The KPI displays four different metrics (if you elect to use all of them), so there is a little bit more configuration 

required for this FactoryWidget.  

 
 

 

Data Source 

WidgetServer Name  Enter your FactoryWidget server name. It must 
be an alphanumeric value. This is the Windows 
computer name of the machine hosting the 
WidgetServer. You may also enter the IP 
address of the server PC on which the 
WidgetServer is hosted. 
 
Double-check for misspellings if you receive an 
“invalid” error upon entry. 

Advanced Data Source Settings  

 Click link to show hidden fields. 

 Fields are hidden because it is not always necessary to fill these 
in if the data source and port are defined in the WidgetServer. 

   Data Source Name If the data source you want to use for this 
FactoryWidget is the same data source that is 
selected as the default data source in the 
WidgetServer Configurator, then you do not 
need to enter it again.  
 
To connect to a data source other than the 
default, enter that data source name here, as 
it appears in the WidgetServer Configurator. 
Double-check for misspellings if you receive an 
“invalid” error upon entry. 

   WidgetServer Port This is the TCP/IP port number on which the 
WidgetServer is listening. The default is 4700. 
You should only change the port number here 
if you have changed the default on the 
WidgetServer. 

Refresh Rate From the drop-down menu, select the rate at 
which you want the data to the FactoryWidget 
to be refreshed from the data source.  
 
If you do not select a refresh rate, the rate 
defaults to five seconds. 
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Metric 1 (Master Metric) 

Caption Enter a description, acronym, or legend to 
describe what this metric is showing. 

Tagname Enter your tagname. It must be an 
alphanumeric value. If you created an Alias for 
your tags in the WidgetServer Configurator, 
you can enter that here. Note that the Alias as 
entered in the WidgetServer Configurator is 
case-sensitive. 
 
Double-check for misspellings if you receive an 
“invalid” error upon entry. 

Unit of Measure Enter any unit of measure you require for the 
data you are tracking (EUs, units, %, etc.). 

Display Value Format From the drop-down menu, select the decimal 
format you want the FactoryWidget to 
recognize and use for your data values for this 
metric. The format you select displays under 
Preview. 

Goal Setpoint Indicate what kind of goal setpoint you are 
using by selecting Server Tag or Manual. 
 
Then enter the appropriate goal setpoint. If 
using a server tag, the setpoint will be a 
setpoint tagname. If using a manual goal 
setpoint, the value may be positive or 
negative. 
 
Double-check for misspellings if you receive an 
“invalid” error upon entry. 

Display Goal This checkbox is checked by default. You can 
click to remove the check if you do not want to 
show the goal setpoint when the 
FactoryWidget is running.  
 
When you remove the check in this box, the 
unit of measure also does not display if it is 
not defined. 
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Metric 2 

Enabled Check Enabled if you are using this metric.  
 
If you do not enable this metric, you cannot 
enter data in this window and the progress bar 
associated with this metric does not display on 
the FactoryWidget. 

Caption Enter a description, acronym, or legend to 
describe what this metric is showing. 

Tagname Enter your tagname. It must be an 
alphanumeric value. If you created an Alias for 
your tags in the WidgetServer Configurator, 
you can enter that here. Note that the Alias as 
entered in the WidgetServer Configurator is 
case-sensitive. 
 
Double-check for misspellings if you receive an 
“invalid” error upon entry. 

Unit of Measure Enter any unit of measure you require for the 
data you are tracking (EUs, units, %, etc.). 

Display Value Format From the drop-down menu, select the decimal 
format you want the FactoryWidget to 
recognize and use for your data values for this 
metric. The format you select displays under 
Preview. 

Goal Setpoint Indicate what kind of goal setpoint you are 
using by selecting Server Tag or Manual. 
 
Then enter the appropriate goal setpoint. If 
using a server tag, the setpoint will be a 
setpoint tagname. If using a manual goal 
setpoint, the value may be positive or 
negative. 
 
Double-check for misspellings if you receive an 
“invalid” error upon entry. 

 Display Goal This checkbox is checked by default. You can 
click to remove the check if you do not want to 
show the goal setpoint when the 
FactoryWidget is running.  
 
When you remove the check in this box, the 
unit of measure also does not display if it is 
not defined. 

 If you elect to use Metrics 3 and 4, use the same steps to configure those metrics as for Metric 2.  
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Color tab 

>  Body 
>  Progress 1   
>  Progress 2 
>  Progress 3 
>  Progress 4 

For each of the four metrics (if all are used) configured in the Data Source > Metric X windows, there is a 

corresponding progress bar to configure as well. Use this tab to set the value limits and the color the progress 

bar should be when the value exceeds or drops below the specified value.  

 
 

Body 

FactoryWidget
TM

 Color From the drop-down menu, select the color 
you would like the FactoryWidget to display. 
This is a static color and will not change once 
selected. 
 
If you do not select a color, black defaults. 

Text Color Click inside the text color box to display the 
color-picker. Select the color you would like 
the text to display on the FactoryWidget. This 
is a static color and will not change once 
selected.  
 
Once you have selected a color, it displays in 
the text box. If you do not select a color, white 
defaults. 

 
The display value format that you selected on each Data Source > Metric tab(s) display(s) at the bottom of the 

Color > Progress tab(s) as a reminder to enter your value limits in the decimal format you selected for that 

metric. You can enter positive and negative value limits. The highest value must be in the High High limit field, 

the next highest value must be in the High limit field, and so on, with the lowest value being in the Low Low 

limit field. 
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Progress 1 

High High 

   Text Click inside the text color box to display the 
color-picker. Select the color of text you would 
like to display on the progress bar when it 
exceeds the “High High” level.  
 
Once you have selected a color, it displays in 
the text box. If you do not select a color, white 
defaults. 

   Progress Bar From the drop-down menu, select the color 
you would like the progress bar to display 
when it exceeds the “High High” level. 

   Limit Enter a limit. When the data source value 
exceeds this threshold value, the progress bar 
changes colors according to the settings you 
have indicated for this “High High” limit. 

High 

   Text Click inside the text color box to display the 
color-picker. Select the color of text you would 
like to display on the progress bar when it 
exceeds the “High” level.  
 
Once you have selected a color, it displays in 
the text box. If you do not select a color, white 
defaults. 

   Progress Bar From the drop-down menu, select the color 
you would like the progress bar to display 
when it exceeds the “High” level. 

   Limit Enter a limit. When the data source value 
exceeds this threshold value, the progress bar 
changes colors according to the settings you 
have indicated for this “High” limit. 

Normal 

   Text Click inside the text color box to display the 
color-picker. Select the color of text you would 
like to display on the progress bar when it is 
the “Normal” level.  
 
Once you have selected a color, it displays in 
the text box. If you do not select a color, white 
defaults. 

   Progress Bar From the drop-down menu, select the color 
you would like the progress bar to display 
when it is the “Normal” level. 
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 Low 

   Text Click inside the text color box to display the 
color-picker. Select the color of text you would 
like to display on the progress bar when it 
drops below the “Low” level.  
 
Once you have selected a color, it displays in 
the text box. If you do not select a color, white 
defaults. 

   Progress Bar From the drop-down menu, select the color 
you would like the progress bar to display 
when it drops below the “Low” level. 

   Limit Enter a limit. When the data source value 
drops below this threshold value, the progress 
bar changes colors according to the settings 
you have indicated for this “Low” limit. 

Low Low 

   Text Click inside the text color box to display the 
color-picker. Select the color of text you would 
like to display on the progress bar when it 
drops below the “Low Low” level.  
 
Once you have selected a color, it displays in 
the text box. If you do not select a color, white 
defaults. 

   Progress Bar From the drop-down menu, select the color 
you would like the progress bar to display 
when it drops below the “Low Low” level. 

   Limit Enter a limit. When the data source value 
drops below this threshold value, the progress 
bar changes colors according to the settings 
you have indicated for this “Low Low” limit. 

Background From the drop-down menu, select the color 
you would like to display as the background to 
the progress bar. 

 If you elect to use Metrics 2, 3 and 4, use the same steps to configure those metrics and progress bars as for 

Metric 1.  
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FactoryWidgetTM tab 

Use the FactoryWidgetTM tab to give your widget a custom title and tooltip, and to link it to any Web site of your 

choice. 
 

 

Title Enter the title you have selected for this 
FactoryWidget.  
 
If you do not enter a title, “KPI” defaults. 

Tooltip Enter the tooltip you would like the 
FactoryWidget to display when you single-click 
the widget on your desktop.  
 
If you do not enter a tooltip, “KPI” defaults. 

User-defined Web Link Select the appropriate protocol from the drop-
down list, and then enter a Web link to which 
you would like to link to from this KPI.  
 
Note that because you have selected the 
protocol in the drop-down, you do not have to 
enter that again as part of the Web address. 
 
When the FactoryWidget is running on your 
desktop, hover your mouse over any of the 
progress bars on the FactoryWidget face. 
When the cursor turns into the pointing finger 

( ), click to go to the link you defined. 

 Remember to click OK to save the configuration settings. 
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4.3.1.5 Readerboard 

Use the following guidelines to configure the Data Source, Color, and FactoryWidgetTM tabs of the Readerboard.  

 

 

 

 

 

 
The Readerboard displays manufacturing and process text messages in real 
time. It changes color and/or blinks according to configurable priorities. (The 
text messages seen at left are examples of the rotating text displayed on a 
Readerboard.) 

Readerboard uses a script instruction from a control system, HMI or PLC software to display dynamic data values 

in a fixed text message. For example, the following is a script from Wonderware InTouch HMI software: 

MessageTagName = “Current plant OEE is “ + TEXT(KPI_OEE, “#”) + “%”; 

 MessageTagName is the name of a message tag defined in InTouch. 

 KPI_OEE is an analog tag also defined in InTouch that contains the calculated value of overall 

equipment effectiveness (OEE). 

 This script displays the fixed text (“Current plant OEE is “ and “%”), converts the numerical value of 

KPI_OEE to text, displays it in integer format, concatenates it to the fixed text message. 

 The value of KPI_OEE updates dynamically and is embedded in the fixed text message. 

By using the MessageTagName as the tagname in the Data Source tab when configuring Readerboard, the 

FactoryWidgetTM displays ”Current plant OEE is 95%” with the OEE value updating when the value is updated in 

InTouch. 
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Data Source tab 

>  Data Source 
>  Priority 1 
>  Priority 2 

The Readerboard displays a “normal” state and two priority states, Priority 1 and Priority 2. The normal state is 

required while the priority states are optional. 

 
 

 

Data Source 

WidgetServer Name  Enter your FactoryWidget server name. It must 
be an alphanumeric value. This is the Windows 
computer name of the machine hosting the 
WidgetServer. You may also enter the IP 
address of the server PC on which the 
WidgetServer is hosted. 
 
Double-check for misspellings if you receive an 
“invalid” error upon entry. 

Advanced Data Source Settings  

 Click link to show hidden fields. 

 Fields are hidden because it is not always necessary to fill these 
in if the data source and port are defined in the WidgetServer. 

   Data Source Name If the data source you want to use for this 
FactoryWidget is the same data source that is 
selected as the default data source in the 
WidgetServer Configurator, then you do not 
need to enter it again.  
 
To connect to a data source other than the 
default, enter that data source name here, as 
it appears in the WidgetServer Configurator. 
Double-check for misspellings if you receive an 
“invalid” error upon entry. 

   WidgetServer Port This is the TCP/IP port number on which the 
WidgetServer is listening. The default is 4700. 
You should only change the port number here 
if you have changed the default on the 
WidgetServer. 

Tagname Enter your tagname. It must be an 
alphanumeric value. If you created an Alias for 
your tags in the WidgetServer Configurator, 
you can enter that here. Note that the Alias as 
entered in the WidgetServer Configurator is 
case-sensitive. 
 
Double-check for misspellings if you receive an 
“invalid” error upon entry. 
 

→ Note:  Readerboard can display 
analog and discrete values 
if such tagnames are 
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entered here, but the 
values are given no 
context. Therefore, the 
string tagname is best-
suited and recommended. 

 

 

 

Refresh Rate From the drop-down menu, select the rate at 
which you want the data to the FactoryWidget 
to be refreshed from the data source.  
 
If you do not select a refresh rate, the rate 
defaults to five seconds. 

Text Alignment From the drop-down menu, select how the 
text will align on the face of the FactoryWidget 
– left, center or right. 

Size From the drop-down menu, select how large 
you want the FactoryWidget to display on the 
screen – 256x25, 1024x100, 1280x100 or 
1920x120. 

 

The “normal” state was defined in Data Source > Data Source tab; enable and define the optional priority states 

in the Data Source > Priority X tabs. If both priority levels are enabled, Priority 1 supersedes Priority 2.  

 

Priority 1 

Enabled Click the checkbox to enable this priority level 
for use. 
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Flag Enter the flag tagname as defined in your data 
source. It is a discrete (on/off) tag. 

 

 

Priority 2 

Enabled  Click the checkbox to enable this priority level 
for use. 

Flag Enter the flag tagname as defined in your data 
source. It is a discrete (on/off) tag. 

 

Color tab 

Use the color tab to set the body and text color of the FactoryWidget that will display on the face of the 

FactoryWidgetTM for the normal, Priority 1 and Priority 2 states. You can also make the text flash for either or 

both priority levels. 

 

Normal 

Text Click inside the text color box to display the 
color-picker. Select the color you would like 
the text to display on the FactoryWidget. This 
is a static color and will not change once 
selected.  

FactoryWidget From the drop-down menu, select the color 
you would like the body to display when it’s in 
the normal range. 

Priority 1 

Text Click inside the text color box to display the 
color-picker. Select the color you would like 
the text to display on the FactoryWidget. This 
is a static color and will not change once 
selected.  

FactoryWidget From the drop-down menu, select the color 
you would like the body to display when it 
reaches the Priority 1 range. 
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Flash Click the checkbox if you want the text to flash 
when this priority level has been reached. 

 

 Priority 2 

Text Click inside the text color box to display the 
color-picker. Select the color you would like 
the text to display on the FactoryWidget. This 
is a static color and will not change once 
selected.  

FactoryWidget From the drop-down menu, select the color 
you would like the body to display when it 
reaches the Priority 2 range. 

Flash Click the checkbox if you want the text to flash 
when this priority level has been reached. 

 

FactoryWidgetTM tab  

Use the FactoryWidgetTM tab to give your widget a custom title and tooltip, and to link it to any Web site of your 

choice.  

 

Tooltip Enter the tooltip you would like the 
FactoryWidget to display when you single-click 
the widget on your desktop.  
 
If you do not enter a tooltip, ”Readerboard” 
defaults. 

User-defined Web Link Select the appropriate protocol from the drop-
down list, and then enter a Web link to which 
you would like to link to from this Timer.  
 
Note that because you have selected the 
protocol in the drop-down, you do not have to 
enter that again as part of the Web address. 
 
When the FactoryWidget is running on your 
desktop, hover your mouse over the elapsed 
time display on the FactoryWidget face. When 

the cursor turns into the pointing finger ( ), 
click to go to the link you defined. 
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4.3.1.6 Timer 

Use the following guidelines to configure the Data Source, Color, and FactoryWidgetTM tabs of the Timer.  

 

 
The Timer displays total elapsed time of manufacturing or process steps. 
Timing starts, stops, resumes, and resets based on state changes of discrete 
events. 

 

Data Source tab 

 
 

 

WidgetServer Name  Enter your FactoryWidget server name. It must 
be an alphanumeric value. This is the Windows 
computer name of the machine hosting the 
WidgetServer. You may also enter the IP 
address of the server PC on which the 
WidgetServer is hosted. 
 
Double-check for misspellings if you receive an 
“invalid” error upon entry. 

Advanced Data Source Settings  

 Click link to show hidden fields. 

 Fields are hidden because it is not always necessary to fill these 
in if the data source and port are defined in the WidgetServer. 

   Data Source Name If the data source you want to use for this 
FactoryWidget is the same data source that is 
selected as the default data source in the 
WidgetServer Configurator, then you do not 
need to enter it again.  
 
To connect to a data source other than the 
default, enter that data source name here, as 
it appears in the WidgetServer Configurator. 
Double-check for misspellings if you receive an 
“invalid” error upon entry. 

   WidgetServer Port This is the TCP/IP port number on which the 
WidgetServer is listening. The default is 4700. 
You should only change the port number here 
if you have changed the default on the 
WidgetServer. 

Time while / is Enter your tagname (up to 64 characters). It 
must be an alphanumeric value. If you created 
an Alias for your tags in the WidgetServer 
Configurator, you can enter that here. Note 
that the Alias as entered in the WidgetServer 
Configurator is case-sensitive. 
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Select True from the drop-down to the right of 
the Time while field. This indicates that you 
want the FactoryWidget to time the period 
when the data associated with this tagname is 
running (true). Or conversely, select False to 
time when the data associated with the 
tagname is stopped (false).  
 
Double-check for misspellings if you receive an 
“invalid” error upon entry. 

 Reset when / transitions 
to 

Enter tagname (up to 64 characters). It must 
be an alphanumeric value. If you created an 
Alias for your tags in the WidgetServer 
Configurator, you can enter that here. Note 
that the Alias as entered in the WidgetServer 
Configurator is case-sensitive. 
 
Select True from the drop-down to the right of 
the Reset when field. This indicates that you 
want the FactoryWidget to reset the timer 
when the data associated with this tagname 
transitions from stopped (false) to running 
(true). Or conversely, select False to reset the 
timer when the data associated with the 
tagname transitions from running (true) to 
stopped (false). This parameter is optional.  
 
Double-check for misspellings if you receive an 
“invalid” error upon entry. 

Refresh Rate From the drop-down menu, select the rate at 
which you want the data to the FactoryWidget 
to be refreshed from the data source.  
 
If you do not select a refresh rate, the rate 
defaults to five seconds. 
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Color tab 

Use the color tab to set the body and text color of the FactoryWidget. 

 

FactoryWidget
TM

 Color From the drop-down menu, select the color 
you would like the FactoryWidget to display. 
This is a static color and will not change once 
selected. 
 
If you do not select a color, green defaults. 

Title Text Color Click inside the text color box to display the 
color-picker. Select the color you would like 
the text to display on the FactoryWidget. This 
is a static color and will not change once 
selected.  
 
Once you have selected a color, it displays in 
the text box. If you do not select a color, white 
defaults. 

 

FactoryWidgetTM tab  

Use the FactoryWidgetTM tab to give your widget a custom title and tooltip, and to link it to any Web site of your 

choice.  

 

Title Enter the title you have selected for this 
FactoryWidget.  
 
If you do not enter a title, “Timer” defaults. 

Tooltip Enter the tooltip you would like the 
FactoryWidget to display when you single-click 
the widget on your desktop.  
 
If you do not enter a tooltip, “Timer” defaults. 

User-defined Web Link Select the appropriate protocol from the drop-
down list, and then enter a Web link to which 
you would like to link to from this Timer.  
 
Note that because you have selected the 
protocol in the drop-down, you do not have to 
enter that again as part of the Web address. 
 
When the FactoryWidget is running on your 
desktop, hover your mouse over the elapsed 
time display on the FactoryWidget face. When 

the cursor turns into the pointing finger ( ), 
click to go to the link you defined. 
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4.3.2 Saving and Loading Settings  

With the Save and Load task bar, you can save your FactoryWidgets’ configuration settings in the WidgetServer 

Configurator.  

Figure 54: Save and Load taskbar in FactoryWidget's Options window 

 

By saving them, they can be made available for other users, they are stored for future use if you elect to switch 

to another configuration and later want to change back, or they can simply serve as a backup in case you 

inadvertently change your configuration settings. The Save Settings feature is also very useful when upgrading to 

new versions of FactoryWidgets; you can save your current configuration, upgrade to the new version, and then 

load the configuration into the new version without having to manually enter configuration settings again. There 

is no limit to the number of configurations you can save. 

To save your current configuration settings:  

 

1. Right-click your FactoryWidget and select Options to open the 

Options window. 

2. Click Save Settings ( ) and enter a name in the Settings Name field 

under which you are going to save your current FactoryWidget 

configuration settings.   

3. Enter an optional description and then click Save. The Settings Name 

field cannot be blank; the configuration will not save without a name. 

→ Note: After selecting the settings name and optional 
description, be sure to click Save in the Save 
Settings pop-up window to save your settings. If 
you click the Option window’s OK button, you will 
lose your Save settings. 

 

 

If you have previously saved a configuration that you wish to overwrite, you may select the name of the existing 

configuration from the Settings Name drop-down list, and click Save. (The drop-down list displays all previously 

saved configurations for the FactoryWidget type you are configuring.) However, you cannot overwrite a global 

configuration; you can only load a global configuration, then edit and save it under a new name.  
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To load existing configuration settings: 

 

1. Right-click your FactoryWidget and select Options to open the 

Options window. 

2. Click Load Settings ( ) and select the name of the configuration 

you want to load from the Settings Name drop-down list. You can 

select any existing global configuration created by anyone or any 

configuration you previously created. (The global designation is made 

in the Widget Settings tab in the WidgetServer Configurator.) 

3. Click Load. The Settings Name field cannot be blank; the 

configuration will not load without a name. 

→ Note: After selecting the settings name and optional 
description, be sure to click Load in the Load 
Settings pop-up window to load your settings. If 
you click the Option window’s OK button, you will 
lose your Load settings. 

 

After you save a configuration, you may view this and other saved configurations in the Widget Settings tab in 

the WidgetServer Configurator on the server.  

Figure 55: Widget Settings tab 

 

 Open the WidgetServer Configurator, click the View menu, and select Widget Settings. 

 If you want to make your configuration available to others, click the Global checkbox. A global 

configuration is one that others can load, but cannot overwrite.  

 To edit a configuration name or description in the Widget Settings tab, double-click inside the field to 

edit.  

 To delete a configuration, select the configuration and press Delete or right-click the configuration and 

click Delete. 
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5 TROUBLESHOOTING 

If see errors with the FactoryWidgets, review the error messages below for guidance about how to resolve 

them. If you are having issues connecting to valid data sources, you can test your data source connection and 

your tag names using the WidgetServer Configurator. Contact Support if you cannot resolve errors or issues. 

5.1 FactoryWidget Error Messages 

You may see any of the following error messages if, when configuring the FactoryWidgets, some data was not 

entered, or invalid data was entered. Review the messages below for more explanation about what they 

indicate and how to resolve them. 

Error Message Description/Remedy 
BAD DATA QUALITY The data stream from the data source is not available. This means the 

input/output (I/O) server providing data to the control system is experiencing 
an issue. Check the status of that server. 

DATA SOURCE NOT 
CONFIGURED 

There is no data source name entered in the FactoryWidgetTM Options window. 
Enter a valid data source in the Data Source Name field. 

Flash cannot be configured for 
this Priority unless it is 
enabled. Go to Priority tab to 
enable. 

The priority level for which you are trying enable flashing text in not enabled. Go 
to the tab for that priority and click Enabled. 

INVALID DATA SOURCE NAME 
OR DATA SOURCE NOT 
AVAILABLE 

The data source name entered in the FactoryWidgetTM Options window is invalid 
(misspelled or does not exist), or the data source is not currently available. Check 
the entry in the Data Source Name field.  

INVALID PRIORITY 1 FLAG 
TAGNAME 

The flag tagname entered in the FactoryWidgetTM Options window in the Priority 1 
tab is invalid (misspelled or does not exist). Check the entry in your Flag field. 

INVALID PRIORITY 2 FLAG 
TAGNAME 

The flag tagname entered in the FactoryWidgetTM Options window in the Priority 2 
tab is invalid (misspelled or does not exist). Check the entry in your Flag field. 

INVALID SETPOINT If you have the setpoint type set to Manual in the FactoryWidgetTM Options 
window, the setpoint goal entry field is invalid (misspelled or does not exist). 
Check the entry in your setpoint entry field. 

INVALID SETPOINT TAGNAME If you have the setpoint type set to Server Tag in the FactoryWidgetTM Options 
window, the setpoint tagname entered is invalid (misspelled or does not exist). 
Check the entry in your Setpoint Tagname field. 

INVALID TAGNAME The tagname entered in the FactoryWidgetTM Options window is invalid 
(misspelled or does not exist). Check the entry in your Tagname field. 

INVALID TIMESTAMP The UTC time (time zone adjusted) clocks on the client computer and the 
computer where WidgetServer is running are out of synch by more than five 
minutes. Set up the computers to synchronize their clocks with a common time 
source. If this is not possible, contact technical support for details on an alternative 
workaround solution.  

INVALID WIDGETSERVER NAME 
OR WIDGETSERVER NOT 
CONFIGURED 

The WidgetServer name entered in the FactoryWidgetTM Options window is invalid 
(misspelled or does not exist), or there is no name entered. Check your entry in 
WidgetServer Name field.  

NO CONNECTIVITY TO DATA The desktop computer has lost its network connection. Check for a loose or 
disconnected network cable. 
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Error Message Description/Remedy 
NO LICENSES AVAILABLE There is not a license available for the FactoryWidgetTM you are trying to configure 

on the desktop. Go to the Options menu in the WidgetServer Configurator and 
assign an open license or purchase an additional license. 
 

No widget settings found. 
Please check your server name 
and settings name, and try 
again. 

You are trying to load a configuration to your FactoryWidgetTM that does not exist. 
If you select an existing configuration to load, you must click Load to first load that 
configuration with its existing name; then, click Save Settings, change the Settings 
Name to something else, and click Save. If you select a configuration to load, and 
then modify the name before clicking Load, you will receive this error. 

PRIORITY 1 FLAG NOT 
CONFIGURED 

The Priority 1 tab for the Readerboard FactoryWidgetTM has been enabled, but 
there is no flag entered in the FactoryWidget’s Options window. Enter a valid data 
source in the Flag field. 

PRIORITY 2 FLAG NOT 
CONFIGURED 

The Priority 2 tab for the Readerboard FactoryWidgetTM has been enabled, but 
there is no flag entered in the FactoryWidget’s Options window. Enter a valid data 
source in the Flag field. 

SETPOINT NOT CONFIGURED If you have the setpoint type set to Manual in the FactoryWidget Options window, 
there is no setpoint goal entered. Enter a valid setpoint in the setpoint entry field. 

TAGNAME NOT CONFIGURED There is no tagname entered in the FactoryWidgetTM Options window. Enter a 
valid tagname in the Tagname field. 

USER NOT FOUND You may see this error message when the WidgetServer is configured for “Seat 
Licensing” mode, and the user is not in the database (that is, they have not yet 
been added to the WidgetServer Configurator’s User Licenses tab). Users are 
automatically added to the database if you are using “Concurrent Licensing” mode, 
but they are not automatically added when using “Seat Licensing” mode. Make 
sure the user is added to the User Licenses tab in the WidgetServer Configurator.  

WIDGET SERVER AND 
FACTORYWIDGET VERSION 
MISMATCH 

The WidgetServer version number does not match the FactoryWidgetTM version 
number. You can see the version number of the WidgetServer by checking the 
status bar in the WidgetServer Configurator, and you can see the FactoryWidgetTM 
version number by going to the About tab in its Options menu. Make sure you 
have the same newest version of both the WidgetServer and FactoryWidgetTM.   
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5.2 Testing Connections in WidgetServer Configurator 

If you are having issues connecting to a valid data source, you can test your data source and WidgetServer using 

the WidgetServer Configurator.  

 Open the WidgetServer Configurator.  

5.2.1 Testing Data Sources 

1. To test the data source, enter the following information. 

a. For a Historian-type data source, go to the View > Data Source > Historian tab and enter the 

following information in a row: 

o Data source name 
o Server  
o Username 
o User password 

 
b. For an OPC-type data source, go to the View > Data Source > OPC tab and enter the following 

information in a row: 

o Data source name 
o Computer name 
o OPC server 

 
2. Click Test Data Source. A new tab opens to display the results of the test. 

 

If a successful connection is made, “success” message in green displays, indicating the data entered is 

valid. If a “failure” message in red displays, the data entered in one or more of the four fields you 

configured is invalid, the data source is not available, or network configuration issues prevent you from 

connecting to the data source. Check your data and your spelling and try again.  

5.2.2 Testing Tags 

1. To test a tag, you must have already tested and verified your data source in the View > Data Source > 

Historian or OPC tabs. If you have not already done so, test your data source now before proceeding. 

 

2. Now, in the same row where you verified the data source, click Test Tag. A new tab opens to test a tag 

name. 

 

3. Enter a tag name and click Test or press Enter. 

If the tag name is valid, the parameters associated with that tag or a “Valid Tag” message display. If the 

tag name is not valid, a “Tag Not Found” message displays. An invalid tag name is one that is either not 

in use with the data source, or the tag name contains a typo. Double-check the spelling of the tag name 

and try again.  
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5.3 Contacting Support 

When you contacting Software Toolbox for support, having the following information ready: 

 Customer and order information 

 Product serial number (provided at the time of purchase) 

 The serial number of your FactoryWidgets license, which is listed in the WidgetServer. 

As much of the following information that you can provide is also very helpful and helps technicians to help you 

resolve issues more quickly:  

 Nature of the problem  (e.g., installation, configuration, functionality of a FactoryWidget) 

 Version of WidgetServer, which is listed in WidgetServer Configurator status bar in the lower right. It 

can also be found by clicking Help > About in the WidgetServer Configurator. 

 Operating System on which you are running the WidgetServer.  

 Version of the affected FactoryWidget(s), which is found by opening the FactoryWidget Options 

window, and clicking About. 

 Operating system of the client system(s) if issue involves a FactoryWidget on a client computer. 

 Description of the symptom in the form of “actual behavior” vs. “expected behavior,” error 

messages you are seeing, and if possible, steps to replicate the issue. 

 Email address to which you have access and a phone number where you can be reached.   

5.3.1 Software Toolbox Support 

 Phone  

1-704-849-2773 

Normal business hours: Monday to Friday, 8 AM to 5 PM, Eastern Std. Time (GMT -5) 

 Email 

Please submit an inquiry via our support portal at http://support.softwaretoolbox.com. This insures 

fastest handling as all of our staff monitors this for any type of inquiry.  

 Web 

Technical Support: http://support.softwaretoolbox.com 

 

  

http://support.softwaretoolbox.com./
http://support.softwaretoolbox.com/
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APPENDIX A – LICENSING AGREEMENT 

APEX Software Development LLC License Agreement 
 

PLEASE READ THIS AGREEMENT CAREFULLY. BY INSTALLING OR OTHERWISE USING THE APEX SOFTWARE, YOU AGREE TO 
THE TERMS OF THIS AGREEMENT. IF YOU DO NOT AGREE WITH THESE TERMS, DO NOT DOWNLOAD, INSTALL OR USE THE 
APEX SOFTWARE. THE APEX SOFTWARE MAY NOT BE SOLD, TRANSFERRED, OR FURTHER DISTRIBUTED EXCEPT AS 
AUTHORIZED APEX SOFTWARE DEVELOPMENT LLC. 
 
This APEX Software License Agreement (this “Agreement”) is a legal agreement between you (an entity or a person) and 
APEX Software Development LLC (“APEX”). The software product identified in the title of this Agreement, media (if any), 
and accompanying documentation (collectively, the “Software”) is protected by the copyright laws and other laws and 
treaties of the United States (“U.S.”) and other countries and is subject to the terms of this Agreement. If you do not agree 
with the terms of this Agreement, do not download, install, or otherwise use the Software and, if applicable, return the 
entire unused package to APEX with your invoice and proof of payment for a full refund. The Software is licensed to you, 
not sold. 
 
The Software may include or be bundled with other software programs licensed under different terms and/or licensed by a 
vendor other than APEX. Use of any software programs accompanied by a separate license agreement is governed by that 
separate license agreement. Any third party software that may be provided with the Software is included for use at your 
option. APEX is not responsible for any third party’s software and shall have no liability for your use of third party software. 
 
1. Grant of License.  Subject to the terms and conditions of this Agreement, APEX grants to you a non-exclusive and 
non-transferable license, without right to sublicense (the “License”), to install, use, execute, and display one copy of the 
WidgetServer component of the Software on a single computer at a single location. The FactoryWidget™ components of 
the Software can be installed on a single or multiple computers, provided the total number of FactoryWidgets™ installed 
does not exceed the total number of FactoryWidget™ licenses purchased. For purposes of this Agreement, a “Computer” is 
defined as a single physical computer or a single instance of a virtual PC, virtual server, whether it be implemented using 
Microsoft Virtual PC, Virtual Server, Hypervisor, VMWare, or other virtual computing software applications that enable 
multiple isolated operating system instances to be run on a single hardware platform.  
 

1.2  Multiple Computers. If you plan to run the WidgetServer component of the Software on multiple 
computers (whether virtual or physical) or servers (whether virtual or physical) a license is required for each instance of 
the computer or where the WidgetServer component Software will be installed.   If you also plan to install the 
WidgetServer component Software in the host operating system of the computer where the virtual machines are 
running, a license will also be required for the host operating system.  The FactoryWidget™ components of the 
Software can be installed on a single or multiple computers, provided the total number of FactoryWidgets™ installed 
does not exceed the total number of FactoryWidget™ licenses purchased. 
 
1.3  Demonstration Mode. If you are running the Software in a demonstration, unlicensed mode, you may not 
automate the stopping and starting of the Software in demo mode or use any other method to attempt to circumvent 
the demonstration mode timeout period.  
 
1.4    Additional Uses. In order to authorize additional uses of the FactoryWidget™ software you must 
purchase additional FactoryWidget™  licenses. A user may not access the Software unless it has a valid license.  
 
1.5  Dual-Media Software.  You may receive the Software in more than one medium. Regardless of the type 
or size of medium you receive, you may use only one medium that is appropriate for the Computer. You may not use or 
install the other medium on another computer. You may not loan, rent, lease, or otherwise transfer the other medium 
to another user, except as part of the permanent transfer (as provided above) of the Software. 
 

 
2. License Restrictions.  APEX reserves all rights not expressly granted to you under this Agreement. You may not (a) 
reverse engineer, decompile, or disassemble the Software, except and only to the extent it is expressly permitted by 
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applicable law; (b) modify, alter, rent, timeshare, or lease the Software or sublicense any of your rights under this 
Agreement; or (c) transfer the Software or your license rights under this Agreement, in whole or in part. 
 
3. Third Party Licenses.  With respect to any portion of the Software licensed by APEX from third parties, you shall be 
bound by the terms and conditions of the license received by APEX from such third parties.  
 
4. Support and Upgrades.   APEX’s initial free warranty and technical support period is 90 days from the purchase 
date of the Software.  Technical support is provided by Software Toolbox, Inc., which provides unlimited e-mail technical 
support for all Software whether a demo or registered license in the first 90 days after purchase. Software Toolbox Inc. will 
provide a total of up to four hours per month of free phone technical support during the initial 90 days to the licensed and 
registered user provided the applicable license fees for use of the Software have been paid.   Software Toolbox Inc. will 
provide unlimited email technical support and up to four hours per month of free phone technical support beyond the initial 
90 day warranty period provided. No onsite support is provided. Upgrades are not included with the initial purchase of the 
Software. Additional technical support, beyond that described herein, plus Software upgrades, is available at an extra cost. 
Terms of that support are covered under separate agreement.  
 
5.   Client Access Licenses. Many software and database vendors require users to purchase licenses that allow 
them to connect to, and access data from, their products. These are sometimes known as Client Access Licenses (CALs). 
Customers who use FactoryWidgets™ to access such data sources, must have the appropriate CALs, as required and 
available from that software or database vendor.  
 
 
6. Ownership.  No title to or ownership in the Software is transferred to you. APEX retains ownership of all Software 
and copies thereof and you acknowledge that all right, title, and interest in and to the Software and any and all trademarks, 
trade names, copyrights, patents, and other intellectual property rights used or embodied in or in connection with the 
Software are and shall at all times remain the sole and exclusive property of APEX. 
 
7.  Return Policy The original licensee of the Software can return it within thirty (30) days of purchase.  Please contact us for 
a Return Material Authorization Number.  Returns after 30 days of purchase may require a restocking fee.  Any extensions 
of this return period must be pre-approved by Software Toolbox technical support and documented in writing, where e-
mail is considered to be in writing.  No returns are accepted without a Return Material Authorization Number.  
 
 
8. Warranty; Liability. 
 
 8.1 Limited Warranty.  For thirty (30) days from your date of purchase, APEX warrants that (a) any media on 
which the Software is delivered is free from physical defects; and (b) the Software will substantially conform to the 
documentation accompanying the Software. If the defective items are returned to APEX, or if you report the nonconformity 
to APEX, within thirty (30) days from the date of purchase APEX will, at its sole discretion, either resolve the nonconformity 
or refund the purchase price you paid for the Software. Any misuse or unauthorized modification of the Software voids this 
warranty. THE SOFTWARE IS ONLY COMPATIBLE WITH CERTAIN COMPUTERS AND OPERATING SYSTEMS. THE SOFTWARE IS 
NOT WARRANTED FOR NON-COMPATIBLE SYSTEMS. Contact APEX for information about compatibility. 
 
 8.2 Non-APEX Products.  The Software may include or be bundled with hardware or other software programs 
licensed or sold by a vendor other than APEX (“Bundled Services”). Without limiting the disclaimer of warranties and 
limitations on liability set forth in this Agreement, you recognize and agree that (a) APEX shall have no liability for the 
quality or performance such Bundled Services, (b) APEX shall not be deemed to have made any representation or warranty 
concerning Bundled Services or the provider of Bundled Services, (c) APEX shall use commercially reasonable efforts to 
enforce its rights under any written agreement it may have with the provider of such Bundled Services; provided, that APEX 
shall have no liability whatsoever for the failure of a provider of Bundled Services to perform its obligations with respect 
thereto, and (d) whenever possible, APEX shall pass through or assign to you any third party service level agreement or 
warranty which APEX receives in connection with any Bundled Services. 
 
 8.3 Warranty Disclaimer.  EXCEPT AS OTHERWISE RESTRICTED BY LAW, APEX DISCLAIMS AND EXCLUDES ANY 
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AND ALL IMPLIED WARRANTIES INCLUDING ANY WARRANTIES OF MERCHANTABILITY, TITLE, NON-INFRINGEMENT, OR 
FITNESS FOR A PARTICULAR PURPOSE. APEX MAKES NO WARRANTY, REPRESENTATION OR PROMISE NOT EXPRESSLY SET 
FORTH IN THIS LIMITED WARRANTY. APEX DOES NOT WARRANT THAT THE SOFTWARE WILL SATISFY YOUR REQUIREMENTS 
OR THAT THE OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED. Some jurisdictions do not allow certain disclaimers 
and limitations of warranties, so portions of the above limitations may not apply to you. This limited warranty gives you 
specific rights and you may also have other rights which vary from state to state. 
 

8.4 LIMITATION OF LIABILITY.  NEITHER APEX NOR ANY OF ITS LICENSORS, SUBSIDIARIES, DISTRIBUTORS, OR 
EMPLOYEES WILL IN ANY CASE BE LIABLE FOR ANY SPECIAL, INCIDENTAL, CONSEQUENTIAL, INDIRECT, TORT, ECONOMIC, 
OR PUNITIVE DAMAGES ARISING OUT OF THE USE OF OR INABILITY TO USE THE SOFTWARE, INCLUDING WITHOUT 
LIMITATION, LOSS OF PROFITS, BUSINESS, DATA, GOODWILL, OR ANTICIPATED SAVINGS, EVEN IF ADVISED OF THE 
POSSIBILITY OF THOSE DAMAGES. IN NO EVENT WILL APEX’S AGGREGATE LIABILITY FOR DIRECT DAMAGES TO PROPERTY 
OR PERSON (WHETHER IN ONE INSTANCE OR A SERIES OF INSTANCES) EXCEED THE AMOUNT PAID BY YOU FOR THE 
SOFTWARE OUT OF WHICH SUCH CLAIM AROSE. In those jurisdictions that do not allow the exclusion or limitation of 
damages, APEX’s liability shall be limited or excluded to the maximum extent allowed within those jurisdictions. 
 
9. Confidentiality.   
 

9.1 Confidential Information.  You hereby acknowledge that you may have access to information that is 
confidential to APEX (“Confidential Information”). Confidential Information shall include the Software, including all related 
source and object codes, any documentation included with the Software, the terms and pricing under this Agreement, and 
trade secrets and intellectual property relating to APEX and the Software. Confidential Information also includes 
information relating to APEX’s business or financial affairs, such as financial results, business methods, pricing, competitor 
and product information, and all other information designated as confidential by the disclosing party. Confidential 
Information shall not include any information that (a) becomes part of the public domain through no act or omission of the 
other party; (b) is lawfully acquired by the other party from a third party without any breach of the third party’s obligations 
to the disclosing party; or (c) is disclosed by the disclosing party to a third party without any obligation of confidentiality by 
the third party. You agree to maintain the confidentiality of the Confidential Information and to protect as a trade secret 
any portion of APEX’s Confidential Information by preventing any unauthorized copying, use, distribution, installation, or 
transfer of possession of such information. You agree to maintain at least the same procedures regarding APEX’s 
Confidential Information that you maintain with respect to your own confidential information. Without limiting the 
generality of the foregoing, you shall not permit anyone to remove any proprietary or other legend or restrictive notice 
contained or included in any material provided by APEX. 
 

9.2 Injunctive Relief.  You acknowledge that any use or disclosure of APEX’s Confidential Information in a 
manner inconsistent with the provisions of this Agreement may cause APEX irreparable damage for which remedies other 
than injunctive relief may be inadequate, and you agree that APEX shall be entitled to seek from a court of competent 
jurisdiction injunctive or other equitable relief to restrain such use or disclosure in addition to other appropriate remedies. 
 

9.3 Survival.  The terms and provisions of this Section 9 shall survive any termination of this Agreement for 
any reason. 
 
10. U.S. Government Restricted Rights.  If you are licensing the Software on behalf of any unit or agency of the United 
States Government, the following applies: The Software is provided with RESTRICTED RIGHTS. Use, duplication, or 
disclosure by the U.S. Government is subject to restrictions as set forth in subparagraphs (a) through (d) of the Commercial 
Computer-Restricted Rights clause at 48 CFR 52.227-19, or in subparagraph (c)(1)(ii) of the Rights in Technical Data and 
Computer Software clause at DFARS 252.227-7013, as applicable, and in similar clauses in the NASA FAR Supplement. 
Contractor/ Manufacturer is APEX Software Development LLC, 1770 State St. Suite 261, Boise, ID 83702, USA.  Tel: +1 (208) 
344-5535. 
 
11. Indemnification.  You shall defend, indemnify, and hold APEX, its officers, directors, and employees, Software 
Toolbox, Inc, and APEX’s distributors harmless from and against any and all claims, damages, losses, costs, or other 
expenses (including reasonable attorneys’ fees) that arise directly or indirectly out of your willful misconduct or 
unpermitted use of the Software. 
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12. General Terms. 
 

12.1 Term.  This Agreement becomes effective on the date you legally acquire the Software and will 
automatically terminate if you breach any of its terms. Upon termination of this Agreement, you must destroy the original 
and all copies of the Software or return them to APEX and delete the Software from your systems. 
 

12.2 Export.  You agree that you do not intend to and will not, directly or indirectly, export or transmit the 
Software or related documentation and technical data to any country to which such export or transmission is restricted by 
any applicable U.S. regulation or statue, without the prior written consent, if required, of the Bureau of Export 
Administration of the U.S. Department of Commerce, or such other governmental entity as may have jurisdiction over such 
export or transmission. You represent and warrant that you are not located in, under the control of, or a national or 
resident of any such country. 
 

12.3 Governing Law.  This Agreement shall be construed in accordance with the laws of the State of Idaho 
(without reference to choice of law principals) and the United States of America.  
 

12.4 Entire Agreement.  This Agreement sets forth the entire understanding and agreement between you and 
APEX and may be amended only in a writing signed by both parties. NO VENDOR, DISTRIBUTOR, DEALER, RETAILER, 
RESELLER, SALES PERSON, OR EMPLOYEE IS AUTHORIZED TO MODIFY THIS AGREEMENT OR TO MAKE ANY 
REPRESENTATION OR PROMISE THAT IS DIFFERENT FROM, OR IN ADDITION TO, THE TERMS OF THIS AGREEMENT. 
 

12.5 Waiver.  No waiver of any right under this Agreement will be effective unless in writing, signed by a duly 
authorized representative of the party to be bound. No waiver of any past or present right arising from any breach or 
failure to perform will be deemed to be a waiver of any future right arising under this Agreement. 
 

12.6 Severability.  If any provision in this Agreement is found to be invalid or unenforceable, that provision will 
be construed, limited, modified, or, if necessary, severed, to the extent necessary, to eliminate its invalidity or 
unenforceability, and the other provisions of this Agreement will remain unaffected. 
 

12.7 Assignment and Successors in Interest.  Neither this Agreement nor any rights granted hereunder to you 
may be assigned or delegated by you, without the written consent of APEX. Without derogating from the aforesaid, this 
Agreement shall inure to the benefit of and be binding upon the successors or assignees of the parties (unless the 
assignment thereof is prohibited hereunder). 

 
 

13.  Trademarks. 
 
FactoryWidgets™ and FactoryWidget™ are trademarks of APEX Software Development LLC. 
Microsoft

®
 is a registered trademark, Windows™ is a trademark of Microsoft Corporation.  Software Toolbox is a registered 

trademark of Software Toolbox Inc. All other trademarks are the property of their respective owners. 

 

 


